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XD 3.6.11
Mirada Medical’s XD 3.6.11 is a software application designed for the rigid and deformable registration of medical image
datasets including PET, CT, MR, and SPECT as well as nuclear medicine planar, planar WB and planar dynamic. Additionally,
XD 3.6.11 provides powerful image viewing capabilities including series image review, and region quantification and tracking.

Topics in this help guide:
• Notices
Find here important notices about the use of XD 3.6.10.
• Overview
Topics describing installation, management, and the first steps of launching the XD application.
• Viewing images
In this section you can find information about viewing images without making significant changes to your session data.
• Performing and managing registration of images
Topics describing the registration of two images and the management of relationships between images.
• Findings
Topics describing the creation and editing of regions and rulers.
• Quantification
Topics describing the use of XD features to perform quantification.
• Customizing XD
Topics describing the customization of XD.
• Saving, loading, and exporting data
Topics describing the saving, importing, and exporting of data from XD.
• Keyboard shortcuts
A list of the available keyboard shortcuts in the XD application.
• Equations and algorithms
In this section you can find information about the equations and algorithms used to calculate various statistics in the XD
application.

Mirada Medical, XD 3.6.11 Help Guide - mm8670-3.6.11-0

5

Notices
Summary: Find here important notices about the use of XD 3.6.10.
In this section you can find information about the product that is of importance for safety or regulatory reasons.
You should also be aware of the following statement:

Note 1
When using SUV calculation during PET assessment certain assumptions are made with regard to the reference time for the
acquisition of the data series. Variability in interpretation of requirements outlined in the DICOM Standard with regard to
determination of the start reference time during acquisition and the time of tracer injection may result in variability in the SUV
values calculated by different vendors.
It is important to note that due to inconsistency of approach throughout the industry, the acquisition time used in SUV
calculation may be any of the acquisition times presented in the DICOM data. It is equally important to note that SUV is
affected by a number of physiological factors which cause variability. Taking these two factors into account, SUV can be
thought of as a simplified measure of radiopharmaceutical uptake which has a complementary rather than directive role in the
assessment, treatment and staging of disease.

2797
In compliance with Council Directive 93/42/EEC.

Manufactured by:
Mirada Medical Ltd.
New Barclay House
234 Botley Road
Oxford
OX2 0HP
United Kingdom
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Date of manufacture: May 2019

https://mirada-medical.com/eifu-xd-3-6-11/

Alternative formats
An online version of the XD 3.6.11 instructions for use (including this help guide) is available at https://mirada-medical.com/
eifu-xd-3-6-11/ and may contain updates that were made in the time since you were delivered your copy of XD 3.6.11.
A physical copy of the XD 3.6.11 instructions for use (including this help guide) is also available upon request from
support@mirada-medical.com.

Topics in this section:
• Regulatory statement
• Warnings
The warnings listed here relate to specific functions and modes of use for the software. These are also listed in applicable
topics elsewhere in the user guide.
• Data supported
XD supports a range of data types.
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Regulatory statement
Device Classification
US: Class II (Picture Archiving and Communications System) device with reference to Section 892.2050, Product Code: LLZ
Image Processing System.
EU: Class IIa

Intended Use
XD 3.6.11 is intended to be used by trained medical professionals including, but not limited to, radiologists, nuclear medicine
physicians, and physicists.
XD 3.6.11 is a software application intended to display and visualize 2D & 3D multi-modal medical image data. The user may
process, render, review, store, print and distribute DICOM 3.0 compliant datasets within the system and/or across computer
networks. Supported modalities include, static and gated CT and PET, and static MR, SPECT and planar NM. The user may
also create, display, print, store and distribute reports resulting from interpretation of the datasets.
XD 3.6.11 allows the user to register combinations of anatomical and functional images and display them with fused and nonfused displays to facilitate the comparison of image data by the user. The result of the registration operation can assist the
user in assessing changes in image data, either within or between examinations and aims to help the user obtain a better
understanding of the combined information that would otherwise have to be visually compared disjointedly.
XD 3.6.11 provides a number of tools such as rulers and region of interests, which are intended to be used for the assessment
of regions of an image to support a clinical workflow. Examples of such workflows include, but are not limited to, the evaluation
of the presence or absence of lesions, determination of treatment response and follow-up.
XD 3.6.11 allows the user to define, import, transform and store and export regions of interest structures and dose volumes in
DICOM RT format for use in radiation therapy planning systems.

Indications for Use
XD 3.6.11 is intended to be used by trained medical professionals including, but not limited to, radiologists, nuclear medicine
physicians, and physicists.
XD 3.6.11 is a software application intended to display and visualize 2D & 3D multi-modal medical image data. The user may
process, render, review, store, print and distribute DICOM 3.0 compliant datasets within the system and/or across computer
networks. Supported modalities include, static and gated CT and PET, and static MR, SPECT and planar NM. The user may
also create, display, print, store and distribute reports resulting from interpretation of the datasets.
XD 3.6.11 allows the user to register combinations of anatomical and functional images and display them with fused and nonfused displays to facilitate the comparison of image data by the user. The result of the registration operation can assist the
user in assessing changes in image data, either within or between examinations and aims to help the user obtain a better
understanding of the combined information that would otherwise have to be visually compared disjointedly.
XD 3.6.11 provides a number of tools such as rulers and region of interests, which are intended to be used for the assessment
of regions of an image to support a clinical workflow. Examples of such workflows include, but are not limited to, the evaluation
of the presence or absence of lesions, determination of treatment response and follow-up.
XD 3.6.11 allows the user to define, import, transform and store and export regions of interest structures and dose volumes in
DICOM RT format for use in radiation therapy planning systems.

Mirada Medical, XD 3.6.11 Help Guide - mm8670-3.6.11-0

8

Contraindications for Use
None known.

Cautions
The device presents medical image information, acquired from scanner systems, which can be used as part of a clinical
diagnostic process, in particular for the diagnosis, staging, treatment assessments and follow up of disease. The clinical
diagnostic process uses many other sources of information to form the assessment of the condition of the patient, including
blood tests, clinical examination, case history and genetic profiles. The information that medical imaging provides, as
presented by XD 3.6.11, is a complement to these standard methods. XD 3.6.11 should not therefore be solely used to directly
drive a clinical decision making process.

Data Compression
XD 3.6.11 does not apply any data compression techniques. Lossy compressed data can be loaded into XD 3.6.11 at the
discretion of users. It is important to understand that the use of lossy compressed data may result in lower quality images that
can affect the accuracy of image display and quantification. Where lossy compressed data has been loaded into XD 3.6.11,
the data will be labelled as such in the application.

Prescription Statement
Caution: Federal law restricts this device to sale by or on the order of a licensed healthcare practitioner.

Computational Performance
Unless explicitly agreed to by Mirada Medical, no responsibility is taken for the duration required to perform functions within
the software environment. Specific performance requirements can only be agreed to if the product is delivered on Mirada
Medical specified hardware.

Accuracy
The actions of the user may directly affect the accuracy of functions within the software environment. Therefore it is the
responsibility of the user to determine if the results of image visualization are satisfactory.

Reporting
While the device is a quality product, manufactured under a rigorous quality control program, it is not a secure repository for
clinical reports. Any comments, images or annotations compiled into any form of report and provisionally stored by the
software environment are at the user’s risk. No responsibility is taken by Mirada Medical for damaged reports, incomplete
record manipulation, storage/retrieval problems or network-based security issues unless specifically agreed.

Security
The software tool may, by virtue of its usage, contain confidential patient information. The security and configuration of the
computing hardware used to execute the software is the responsibility of the end-user. This includes secure imaging local area
networks (LANs), appropriate fire-wall provision, network directory permissions, etc.
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Cyber Security
XD 3.6.11 is designed to use data sent to it in DICOM format only from sources within a hospital network as configured by
users. XD 3.6.11 does not include any firewall or anti-virus protection and is not specifically designed to protect against
malicious attack. Users are strongly advised to ensure that appropriate measures are in place in the infrastructure around XD
3.6.11 to protect against malicious attack as well as to comply with data protection regulations. Such measures may include,
but are not limited to, secure local area networks (LANs), appropriate firewall provision, network directory permissions and
anti-virus protection.

User Credentials
XD 3.6.11 used Windows credentials for some functions. System administrators should ensure that XD 3.6.11 is secured for
use by clinicians only, and users should not share their account details.

Coexistence with other software
While there are currently no known safety issues or performance limitations with regard to XD 3.6.11 coexisting on the same
workstation as other software applications, it is recommended that XD 3.6.11 is not used on a workstation with other software
applications installed.

Printing
Mirada Medical takes no responsibility for the faithfulness or quality of a generated hard-copy result of a printing device not
supplied by Mirada Medical and/or installed/configured by Mirada Medical.

User Installation/Operation
User-performed installation and configuration of the software is entirely at the user’s risk unless otherwise agreed by Mirada
Medical (on the basis of an extended EULA/service contract). This includes any disruption to existing installations, software (or
software licenses) or data loss.

Diagnostic and Therapeutic Restrictions
Use of the software as a primary viewing or diagnostic device
The software is designed as an aid to diagnosis, enabling information to be used as an input into a diagnostic process. Other
methods and procedures should be in place to enable a diagnosis to be reached without the aid of this software. The software
should not be used as the sole basis for forming a diagnosis, to do so would constitute a misuse of the software.
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Warnings
Summary: The warnings listed here relate to specific functions and modes of use for the software. These are also listed in
applicable topics elsewhere in the user guide.

Warning: Unsupported modalities, data or image types may cause the software to function incorrectly, to
return invalid results or to reject the data if an attempt is made to load them into the software. Attempt to
load invalid data along with valid data may cause both sets of data to be rejected by the software.

Warning: Lossy compressed data, by design will reduce image quality. This may impact the ability to view
images with the same accuracy and detail as with non-lossy data. All loaded lossy data is labeled as such
in the viewing window.

Warning: The Maximum Intensity Projection or MIP Renderer is a tool for data visualization in 3D and is
useful for obtaining an overview of the areas within the image data of a high intensity and as a tool to
navigate to those regions. The MIP should not be used as the sole view used to interpret the image data.

Warning: Fused images are displayed within system provided layouts and can be included in user
defined layouts. The modality, quantification information, time point and dataset designation within the
current review mode are displayed for each layer in the fused view to allow identification of each layer.

Warning: Care should be taken to ensure that the slice numbering scheme chosen in XD 3.6.11 matches
that of any system used to launch XD 3.6.11.

Warning: The slice navigation slider is specifically designed to be able to navigate quickly to a desired
area within an image view. As such the slice navigation slider does not display every slice in the view
being navigated from the currently displayed slice to the slice represented by the slider position set.

Warning: The PET SUV from Acquisition calculation underlying the display of this quantification option is
outside the control of Mirada Medical. When PET SUV from Acquisition displays values, the number
displayed is based on the stored value in the image data. Please contact your vendor for further information on
this topic.

Warning: When an automatic registration scheme is set to be run on application load, the results should
be reviewed using the crosshair alignment and the quality control tools available via Registration ->
Registration Manager to ensure that the registration is satisfactory. This is particularly important before
propagation of ROIs between time points.

Warning: When an automatic registration scheme is run with data assignments containing multiple
related series (e.g. Gated CT or PET, Multi-phase CT, Multi-sequence MR), the first series/volume
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assigned is the one used for registration for registrations involving that assignment. This may or may not be the
optimal series/volume to use for registration depending on the acquisition protocol. This can be modified on the
Data Management screen by changing the ‘Anchor’ for the assignment and reviewed on the Registration ->
Registration Manager to ensure that the registrations are satisfactory.

Warning: When propagating ROIs between time points, it is important to check that the threshold used is
appropriate for the data in the time points. For meaningful comparison statistics to be displayed, the
threshold should be the same in each time point.
To see the threshold used, select the region in the time point and view the threshold slider or hover the mouse
over the Region defined in the Regions of Interest panel in the Toolbox. The threshold is also visible on the
Regions Table.

Warning: When defining a 2D ruler, the measurement associated with a line is displayed in the same
color as the line to which it pertains. When the measurements are similar, the colors should be checked to
identify the pertaining line.

Warning: The Create Ruler from Region tool calculates the long and short axes from the ROI selected
using mathematical approximations of the smooth ROI boundary. However, the resulting bi-ruler may not
correspond to what the user considers to be the long and short axes that best characterize the lesion from a
clinical point of view. It is important that the resulting Biruler is visually inspected and compared with the region
used for creation to ensure the results are as desired.

Warning: The Create Ruler from Region tool uses mathematical approximations to the smooth ROI
boundary when calculating the best bi-ruler placement. However, in some rare cases the approximations
may result in a ruler that does not correspond exactly to the displayed boundaries or one that passes slightly
outside the lesion boundary. The user should check the result of the tool to confirm that the ruler meets their
expectations.

Warning: When viewing fused images, artifacts may be introduced by poor alignment of findings between
the image layers in the fused view. It is recommended that the registration accuracy is checked prior to
image interpretation and the transparency of the layers is adjusted appropriately to view the layers in the fused
views.

Warning: When a layout image segment contains multiple planar NM Images from one or more series,
the only way to distinguish to which planar series an image pertains is by the series description text label
on the image segment.

Warning: Gallery images do not individually contain patient identification information due to the potentially
limited size of the image segments. To identify to which images the gallery pertains, system provided
gallery views contain a patient information view segment. The layout editor allows patient information views to be
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added to all user defined layouts and should be used when creating Gallery views.

Warning: The Data QC validation is performed on a per user basis using the validation criteria specified
by each user. The validation does not perform any image quality or registration checks.
This feature requires an advanced license to perform and report validation results. Care should be taken when
utilizing the floating license deployment and using this feature, as launching with a Standard license after an
Advanced license will not perform validation on the data as may be expected.
It should be noted that not all fields are validated, some are for display only. These fields cannot be set to
validate the contents when specifying which fields to validate.

Warning: Functions that rely on the inversion of the registration deformation map such as the cross-hair
alignment and Region of Interest propagation may exhibit inconsistent and asymmetrical behavior in
certain situations. For example, in the Adaptive Planning review mode, if the user were to navigate the cross-hair
to a location A in the Baseline Planning the software will automatically place the cross-hair at a particular
corresponding location, B, in the Current Planning. However, if the user were then to move the cross-hair around
in the Current Planning and then place it back at location B, the position of the cross-hair in the Baseline
Planning may not be at location A.

Warning: When using the Volume Crosshair tool, due to the discrete nature of the image data,
quantization effects may result in a small difference in the statistics displayed on the same data viewed in
fused and non-fused views. This effect may be greater in the presence of a large deformable registration
between the layers. Such differences are generally not clinically significant. However, we recommend that the
user check the magnitude of any differences by comparing the statistics visible in the fused and non-fused views
when using this tool. If the user considers the difference significant for their purposes then the non-fused
statistics should be used. This effect does not occur with the other ROI tools available in the application.

Warning: The frames in a dynamic flow study are played at a uniform rate and not in real-time.

Warning: Due to its definition, the peak value may include voxel values from outside the ROI boundaries
when the ROI is near an adjacent area of the image with high PET values. The user should treat the peak
value with caution where high PET voxels are within 0.7 cm of the ROI boundaries.

Warning: XD 3.6.11 creates the DICOM RT Structure Sets from the selected region as specified in the
DICOM Standard. RTP systems may apply interpolation between the encoded contour control points that
differs from their display in XD 3.6.11. We recommend that the user takes screenshots of the regions used to
create the contours, on an acquisition orientation view, and uses these to compare to the contour displayed
within the RTP system to ensure that the imported contour is an accurate representation.
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Warning: Different interpolation methods may be used by XD 3.6.11 and TPS systems when displaying
contours. This means that when viewing findings in the acquisition orientation, they may appear visually
different between systems. It is recommended that screenshots of loaded findings be taken in the acquisition
view and compared to the same findings as displayed on the TPS to ensure that the imported structures are
accurately represented in XD 3.6.11.

Warning: Regions resulting from performing the Transform to All, Transform to Remaining, Transform to
All within Timepoint and Transform to Remaining within Timepoint actions are highly dependent on the
quality of the registration that exists between the dataset on which the source region exists and all the datasets
to which the region is to be transformed. It is recommended that quality checks be performed within the
Registration Manager screen on the accuracy of the registrations prior to performing a region transformation
action.

Warning: The volume doubling time calculation becomes more robust the larger the regions become. At
small volumes where the region volume consists of only a few voxels, the potential error in the reported
volume may be quite large. The user is advised to use the Data QC screen to check the voxel dimensions when
making a judgement as to how to interpret the volume doubling time. In addition, the volume doubling time
calculation may become very large and sensitive when the volumes in consecutive timepoints are similar.

Warning: Many data roles can load multiple volumes so long as they share a common frame of reference.
Once loaded, XD 3.6.11 will attempt to sort the volumes into a logical order. For gated data, this will be in
a temporal order. Multiple reconstructions of the same raw data can also be loaded, however in such use cases
it may not be possible to consistently order the volumes. While the application is not designed to support multiple
reconstructions of the same data for PET and SPECT (such as FBP and TOF), it is possible to load these
reconstructions simultaneously into the same data role. In this case it is not possible to guarantee that the same
order is maintained over multiple timepoints. The user must check within the Data Management screen to
ensure that the same reconstructions have been assigned to the anchor role.

Warning: Automatically shadowed regions will be quantified in the resolution of the dataset onto which
the region was shadowed. Only voxels whose center lies within the region are considered when
calculating statistics. If the dataset on which the original region was defined and the dataset onto which the
region was shadowed are of a different resolution, the regions may have a different Volume statistic as the
volume will always be a multiple of the voxel volume of the dataset on which the region is defined. For instance,
a region defined on a CT dataset and automatically shadowed onto the PET may have a different Volume
statistic when calculated on the CT compared the Volume statistic calculated on the PET if the CT dataset is of a
different resolution to the PET. It follows that any statistic derived from the Volume statistic (e.g. Volume
Doubling Time) will be different for a finding shadowed between a pair of datasets if the Volume statistic is
different for that finding.

Warning: The CT Region Segmentation tools estimate a lesion boundary based on image contents and
the user initialization and does not attempt any automated detection of lesions. The quality of the results
need to be checked for accuracy by the user prior to being used.
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Warning: Depending on the regions used, it is possible that a region intensity distribution will not sum to
100%.
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Data supported
Summary: XD supports a range of data types.

Supported Image Modalities
The following data types are supported:
• CT
• MR
• PET
• SPECT/NM

Supported Image Types
The following image types are supported:
• Gated CT, NM, PET
• Multi-sequence MR
• Multi-phase CT

Supported Non-Image Data Types
The following non-image types are supported:
• RTSS

Supported Data Types
The following data types are supported:
• Uncompressed:
◦ Explicit Big Endian
▪ Implicit Little Endian
▪ Explicit Little Endian

• Compressed:
◦ Lossless JPEG First Order
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▪ Lossless JPEG
▪ Deflated
▪ Lossy JPEG Baseline
▪ Lossy JPEG Extended
▪ Lossless JPEG 2000
▪ Lossless or Lossy JPEG 2000

Note: The XD 3.6 DICOM Conformance Statement contains a detailed description of supported modalities and
data types.

Warning: Unsupported modalities, data or image types may cause the software to function incorrectly, to
return invalid results or to reject the data if an attempt is made to load them into the software. Attempt to
load invalid data along with valid data may cause both sets of data to be rejected by the software.

Warning: Lossy compressed data, by design will reduce image quality. This may impact the ability to view
images with the same accuracy and detail as with non-lossy data. All loaded lossy data is labeled as such
in the viewing window.

Warning: Different interpolation methods may be used by XD 3.6.11 and TPS systems when displaying
contours. This means that when viewing findings in the acquisition orientation, they may appear visually
different between systems. It is recommended that screenshots of loaded findings be taken in the acquisition
view and compared to the same findings as displayed on the TPS to ensure that the imported structures are
accurately represented in XD 3.6.11.

Warning: Many data roles can load multiple volumes so long as they share a common frame of reference.
Once loaded, XD 3.6.11 will attempt to sort the volumes into a logical order. For gated data, this will be in
a temporal order. Multiple reconstructions of the same raw data can also be loaded, however in such use cases
it may not be possible to consistently order the volumes. While the application is not designed to support multiple
reconstructions of the same data for PET and SPECT (such as FBP and TOF), it is possible to load these
reconstructions simultaneously into the same data role. In this case it is not possible to guarantee that the same
order is maintained over multiple timepoints. The user must check within the Data Management screen to
ensure that the same reconstructions have been assigned to the anchor role.
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Related topics:
• Configuring your data
Assign your data to particular roles to control how they are used and displayed.
• Viewing images
In this section you can find information about viewing images without making significant changes to your session data.
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Overview
Summary: Topics describing installation, management, and the first steps of launching the XD application.

About
You install XD 3.6.11 using an installation package and must use a valid license.
Launch XD from ISP and assign your data to the correct roles for your aims.

Topics in this section:
• Launching XD review modes
Launch the XD application.
• Configuring your data
Assign your data to particular roles to control how they are used and displayed.
• The user interface
An overview of the user interface.
• Support
If you require technical support, a support package provides additional information about your system.
• Data quality control
You can review the attributes of your loaded data.
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Launching XD review modes
Summary: Launch the XD application.

About
When launching XD, you select the data that you want to work with and the review mode that you want to use.

Procedure
To launch XD, complete the following steps:
1. In ISP, select the data that you want to use. If you want to load a saved session, select the images included in the session
and the session data and, if you want to import an RTSS, select these as well.
Note: If loading data with multiple patient IDs, you will be presented with a warning. You should take particular
care to ensure that the data loaded is appropriate in this case.

2. Click a review mode. If you want to guarantee that the Data Configuration window is displayed, press and hold the Ctrl key
when you click the review mode.
Use the following review modes in the following circumstances:
• Use XD General Fusion when you want to use a generic set of layouts for viewing data from different modalities,
phases, or sequences.
• Use XD General Oncology Review when you want to use a generic set of layouts for viewing data from two or
more time points.
• Use XD PET/CT Head/Neck Review when you want to use layouts well suited to the head and neck, multiple
time points, and PET or CT data.
• Use XD PET/CT Melanoma Review when you want to use layouts that provide views for multiple parts of the
body in PET or CT modalities.
• Use XD MR/PET/CT Review when you want to perform a general review on MR, PET, or CT data.
• Use XD Basic NM Review when you want to view NM data without any additional customization
• Use XD PET Review when you want to view PET data without any additional customization.
• Use XD PET/CT Whole Body Review when you want to view the whole body in layouts.
• Use XD Single Volume Review when you have a single volume that you want to view.
3. Depending on the data you loaded and the review mode you chose, you might be presented with the Data Configuration
window. For more information about using the Data Configuration window see Configuring your data.
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Warning: Care should be taken to ensure that the slice numbering scheme chosen in XD 3.6.11 matches
that of any system used to launch XD 3.6.11.

Warning: When an automatic registration scheme is set to be run on application load, the results should
be reviewed using the crosshair alignment and the quality control tools available via Registration ->
Registration Manager to ensure that the registration is satisfactory. This is particularly important before
propagation of ROIs between time points.

Related topics:
• Configuring your data
Assign your data to particular roles to control how they are used and displayed.
• Saving a session
You can save your current session and return to it later.
• Data quality control
You can review the attributes of your loaded data.
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Configuring your data
Summary: Assign your data to particular roles to control how they are used and displayed.

About
When you launch XD, the application assigns data to a set of roles defined by the review mode that you are using. The data
role into which an image or series is placed determines what can be done with the data and how it will be displayed.
If you are unsatisfied by the data assignments generated by XD, you can assign data to roles manually.

Procedure
To manually assign data to roles, complete the following steps:

1. When you launch XD, press and hold the Ctrl key.
The data configuration window opens. In this window, you can drag and drop data from a list into roles. It is likely that XD
has already assigned some data to roles.
Note: You can only assign valid data to a role. For example, some data roles must share a frame of reference.
You can sort the list at the top of the window by any of the columns.

2. (Optional) If you have not already launched the application by using a specific review mode, use the Select a review mode
drop down menu to select the review mode that you want to use.

3. (Optional) To add a time point, click Add Timepoint at the bottom of the window. The added time point is always Current,
with Baseline and Prior time points preceding it.

4. (Optional) To remove a time point, click the cross at the top right corner of the time point’s panel in the window. Other time
points have their labels adjusted to account for the removal of a time point.

5. To assign an image or volume to a data role, click the image or volume from the list and drag it to the data role.

6. To move an image or volume from one data role to another, click the image or volume from the first data role and drag it to
the second.

7. (Optional) To remove an image or volume from a data role, select the image or volume in its data role and then, for that data
role, click the Clear role icon

. If you want to clear all images or volumes from the role, click the Clear role icon

without selecting any of the images or volumes in the role.
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8. (Optional) To clear all assignments and delete all but one time point, click Clear All.

9. (Optional) To revert all assignments and removed or added time points to the state that was originally assigned by the
application, click Reset.

10. Click OK to complete the application launch.

Related topics:
• Viewing images
In this section you can find information about viewing images without making significant changes to your session data.
• Performing and managing registration of images
Topics describing the registration of two images and the management of relationships between images.
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The user interface
Summary: An overview of the user interface.

The toolbar and the toolbox
The toolbar, at the top of the window, and the toolbox, on the left of the window, provide access to various functions regardless
of the screen that you are viewing.
The toolbar provides commonly used tools for manipulating images and views, such as pan, zoom, segmentation, and
showing and hiding various aspects of the user interface. The same tools in the toolbar are displayed for all screens.
The toolbox provides tools that are more specific to the screen you are currently viewing, such as access to secondary
captures or a list of regions. The tools in the toolbox vary depending upon the screen you are viewing. You can show or hide
the toolbox by clicking the Select whether the toolbox is visible icon

in the toolbar.

Note: By clicking the Messages menu at the top of the application window and selecting Show messages, you
can view information from the application related to errors or unexpected data.

Context menus
In XD right clicking in a view or menu presents a context menu. This menu contains different tools depending on where it is
opened, and the tools provided can be customized through the Options window. For more information, see Setting user
preferences. All tools available in the context menu are also available through other menus, the toolbar, or the toolbox.

Screens
XD provides several different screens, each of which serves a particular purpose. At the right end of the toolbar, you can use
the Screen menu to switch between screens. You can also use the Window menu, or use buttons that are shown in the
toolbox for certain screens.

• Layout Screens The layout screens provide a means to view your images. Different layouts suit different purposes,
displaying a different selection of datasets, time points, and orientations. You can also create custom layouts.

• Data QC The Data QC screen provides a means to review the DICOM attributes associated with your data, and to assess
the validation that the application has performed.

• Registration Manager The Registration Manager screen provides a means to assess and adjust the registration between
images that you have loaded into the application.

• Findings Table The Findings Table screen displays the various statistics that can be calculated from the rulers and regions
that you have created on your images.
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• Report The Report screen provides a means to create a report for presenting outside of the XD application.

• Secondary Capture The Secondary Capture screen displays your secondary captures that you have either loaded into the
application or captured yourself.

Layout screens
Layouts are the primary way of viewing images in XD. Each layout presents one or more views, where each view displays an
orientation of an image.
Additionally, a view may display one image overlain on another image, using a customizable color map and transparency level.
In the corners of a view, information about the data is displayed either as static text or active text.
Each review mode makes available a different set of layouts and, if these are not sufficient, you can also create custom
layouts. For more information, see Creating custom layouts.
Data is displayed in views, including patient details and information about the image itself. To hide or show patient details, click
the Select whether patient information is displayed in the views icon

, to hide or show details for navigating the volume,

click the Select whether navigation controls are displayed in the selected view icon
views, click the Select whether the information overlays are visible icon

or, to hide or show all details in

.

Crosshairs can be displayed in views, and by default are linked between orientations and registered images. The crosshairs
allow statistics to be generated for a specific point and are used to position certain fixed-volume regions. To show or hide
volume statistics at the crosshair location, click the Select whether to calculate and display volume statistics at the
crosshair location icon
crosshairs are visible icon

, or, to hide or show the crosshairs and all associated information, click the Select whether the
.

Annotations and findings are also displayed in views. To hide or show regions, click the Select whether ROIs are displayed
in the selected view icon
in the views icon

. To hide or show annotations, click the Select whether annotations and rulers are displayed

.

The toolbox provides tools for viewing layers, adjusting window and level settings, working with findings, accessing secondary
captures, and controlling the display of dynamic data.
For more information, see the Viewing images, Performing and managing registration of images, and Findings topics.
Tip: When you have minimized the application window, the patient name is displayed when you hover your
cursor over the application icon in the Windows taskbar.

Data QC
The Data QC screen displays a table listing the different DICOM attributes and their validation status.
The toolbox provides tools for setting your preferences for data quality control, and for accessing secondary captures.
For more information, see Data quality control.
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Registration Manager
The Registration Manager screen is used to specify relationships between images and to perform or alter registration.
The toolbox provides tools for registration quality control, automatic registration, manual registration, and loading registrations.
For more information, see Performing and managing registration of images.

Findings Table
The Findings Table screen presents statistics and graphs that are generated from findings that you created on your volumes.
Different tabs are available and show different sets of statistics, for example, the PERCIST tab provides statistics pertinent to
PERCIST assessment.
Additionally, you can configure the statistics that appear in the findings table screen, for more information, see Setting user
preferences.
The toolbox provides tools for changing which datasets and time points are used to generate the findings table, for working
with different findings, and for accessing secondary captures.
For more information, see Using the findings table.

Report
The Report screen is used to create a report for use outside of XD. You can generate your report from a pre-supplied template,
a customized template, or you can edit a template to make it suit your needs. Tables of statistics and graphs in the report are
generated directly from application data.
The toolbox provides tools for accessing secondary captures and building your report.
For more information, see Creating a report.

Secondary Capture
The Secondary Capture screen displays a selected secondary capture in the main view.
The toolbox provides tools for choosing which secondary capture to view and for controlling how cines are played.
For more information, see Capturing an image and Exporting secondary captures.

Related topics:
• Manipulating images
Adjust your view of an image.
• Performing and managing registration of images
Topics describing the registration of two images and the management of relationships between images.
• Findings
Topics describing the creation and editing of regions and rulers.
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• Creating custom layouts
You can create custom layouts for viewing a study.
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Support
Summary: If you require technical support, a support package provides additional information about your system.

About
A support package includes the following information:
• Machine settings, such as Name and IP Address
• A configuration comparison list of files found in the XD 3.6.11 bin folder (comparing factory settings to current settings)
• Public and current user settings
• XD 3.6.11 logs that are present on the system, this includes the XD 3.6.11 log, the XD 3.6.11 debug log, and, if present, the
XD 3.6.11 trace log

Procedure
To generate a support package, complete the following steps:

1. Click the Help menu and select Generate Support Package.

2. Choose where to save your support package and click Save. It is not recommended to change the folder name.

You have generated your support package, attach this to your email to technical support.
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Data quality control
Summary: You can review the attributes of your loaded data.

About
While you cannot edit DICOM attributes of your data, XD provides the means to review data attributes.

Procedure
To review your data’s attributes, complete the following steps:

1. Click the Window menu and select Data QC.

2. Click the tab of the data role that you want to review the attributes of.
The table in each tab displays, for the data role, a selection of DICOM attributes at different time points, as well as a
variance column that shows whether the difference between time points is permitted by validation.
Note: The manner in which validation is performed varies between different data types.
Textual data validation is not case sensitive.
Numeric data validation checks whether the data is within the range of the minimum, maximum, and permitted
variance between time points.
Validation between time points fails if data is not present in the validated time point when it is present in the
baseline.

3. To view warnings that have been caused by validation errors in your data, click the Expand icon

in the bottom pane.

4. (Optional) To copy the table to the system clipboard, click Copy Table.

5. (Optional) To save the table as a secondary capture, click Snapshot Table. For information about exporting secondary
captures, see Exporting secondary captures.

6. To configure the attributes that are displayed and validated, click Options in the toolbox. For more information, see Setting
user preferences.
Warning: The Data QC validation is performed on a per user basis using the validation criteria specified
by each user. The validation does not perform any image quality or registration checks.
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This feature requires an advanced license to perform and report validation results. Care should be taken when
utilizing the floating license deployment and using this feature, as launching with a Standard license after an
Advanced license will not perform validation on the data as may be expected.
It should be noted that not all fields are validated, some are for display only. These fields cannot be set to
validate the contents when specifying which fields to validate.

Related topics:
• Setting user preferences
Use the Options window to manage user preferences.
• Exporting secondary captures
Export secondary captures as different image types or a DICOM object.
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Viewing images
Summary: In this section you can find information about viewing images without making significant changes to your session
data.
In XD, you can view two-dimensional images and three-dimensional image volumes. The topics in this section of the user
guide detail the methods by which you can view the image, such as the perspective of a viewport, by obtaining secondary
captures, and as cines.

Topics in this section:
• Manipulating images
Adjust your view of an image.
• Viewing a maximum intensity projection (MIP)
You can view a maximum intensity projection of your dataset.
• Capturing an image
You can capture views for later reference or for use outside of XD.
• Choosing a layout
Select the layout of images with which you want to view your data.
• Interacting with active text
Blue text on an image is active text and can be used to manipulate the image.
• Viewing cines
A cine displays a series of image frames or slices in order.
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Manipulating images
Summary: Adjust your view of an image.

About
XD provides a range of tools for viewing your images. This topic covers the use of the following tools:
• Zoom
• Pan
• Scroll through slices
• Window and level settings
• Overlay transparency
• Rotation

Procedure
To manipulate the manner in which your images are displayed, complete the following steps:

1. At any time, you can toggle between a viewport being maximized or part of a layout by double clicking the viewport. You can
also toggle between the two settings by clicking the Toggle whether the view is maximized icon

.

Tip: All the tools referred to in this topic can also be accessed by right-clicking the image.

2. (Optional) Specify the way in which your different viewports zoom together by clicking the Image menu, selecting Zoom
bindings and choosing one of the following options:
• Select Axial/Coronal+Sagittal to lock the coronal and sagittal planes together and zoom the coronal plane
independently.
• Select Per-Plane to lock all viewports of the same view together.
• Select All to lock all views and viewports to the same zoom settings.
• Select None to only zoom in the viewport that you are using.
3. (Optional) Specify the interpolation method used to visualize data by clicking the Image menu, selecting Interpolation
Method, and choosing one of the following:
• Select Nearest Neighbor to use the closest available value for each voxel.
• Select Linear to use linear interpolation between the nearest available values for each voxel.
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• Select Cubic Spline to use a cubic spline to interpolate between the nearest available values for each voxel.
4. To zoom the image to your desired scale, use one of the following methods:
• Hold the Ctrl key and use your scroll wheel to zoom in and out. Scroll up to zoom in and scroll down to zoom out.
• Click the Zoom into the image icon

and then click the image and drag in the vertical direction to zoom. Drag

upwards to zoom out and drag downwards to zoom in.

5. To locate the views in other viewports to a position in your current viewport, drag the crosshairs to where you want the views
to intersect.
If the crosshairs are not correctly linked between views and orientations, click the Unlink the crosshairs to perform a
manual alignment icon

, drag the crosshairs in different views to align correctly, and then click the Link the crosshairs

based on their current positions icon

.

Warning: Functions that rely on the inversion of the registration deformation map such as the cross-hair
alignment and Region of Interest propagation may exhibit inconsistent and asymmetrical behavior in
certain situations. For example, in the Adaptive Planning review mode, if the user were to navigate the crosshair to a location A in the Baseline Planning the software will automatically place the cross-hair at a particular
corresponding location, B, in the Current Planning. However, if the user were then to move the cross-hair
around in the Current Planning and then place it back at location B, the position of the cross-hair in the
Baseline Planning may not be at location A.

Warning: When using the Volume Crosshair tool, due to the discrete nature of the image data,
quantization effects may result in a small difference in the statistics displayed on the same data viewed
in fused and non-fused views. This effect may be greater in the presence of a large deformable registration
between the layers. Such differences are generally not clinically significant. However, we recommend that the
user check the magnitude of any differences by comparing the statistics visible in the fused and non-fused
views when using this tool. If the user considers the difference significant for their purposes then the non-fused
statistics should be used. This effect does not occur with the other ROI tools available in the application.

6. To pan an image, use one of the following methods:
• Hold the Shift key and then drag the image with your cursor.
• Click the Pan image icon

and then drag the image with your cursor.

Tip: If you have multiple datasets within a timepoint and data role, such as multiple MR sequences or gates of
CT data, you can switch between these by pressing the Left and Right arrow keys.

7. To scroll through slices of a plane, use one of the following methods:
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• Use your scroll wheel to scroll through slices. The direction in which you scroll depends upon the orientation of
the image.
• Click the Navigate through the volume slices icon

and then click and drag the image in the vertical

direction.
• Display the navigation controls by clicking the Select whether navigation controls are displayed in the
selected view icon

and then use the navigation slider bar in the viewport to navigate through the slices of the

volume.

Warning: The slice navigation slider is specifically designed to be able to navigate quickly to a desired
area within an image view. As such the slice navigation slider does not display every slice in the view
being navigated from the currently displayed slice to the slice represented by the slider position set.

8. To adjust the window and level settings, use one of the following methods:

• Use the sliders in the toolbox to adjust the level, by dragging the horizontal bar, and the window, by dragging the
end markers.

• Click the Adjust window and level icon
Adjust the window maximum icon

or, if it is not displayed, select it from the dropdown menu beside the

. Then click the image and drag in the vertical direction to adjust the

window and in the horizontal direction to adjust the level.
• Click the Adjust window maximum icon
the Adjust the window and level icon

or, if it is not displayed, select it from the dropdown menu beside
. Then click the image and drag in the vertical direction to adjust the

maximum value of the window.
• To reset the window and level settings, click the Reset Window/Level icon

.

9. To adjust the transparency of an overlay image, click the Adjust the overlay transparency icon

and then click on the

image and drag in the vertical direction.
Warning: When viewing fused images, artifacts may be introduced by poor alignment of findings
between the image layers in the fused view. It is recommended that the registration accuracy is checked
prior to image interpretation and the transparency of the layers is adjusted appropriately to view the layers in
the fused views.
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10. To rotate your view in the current and linked viewports, click the Rotate MPR views icon

and then click and drag in the

viewport.
When you have rotated a view, an MPR overlay cube is displayed, to show standard orientations in comparison to the
current one. To toggle the display of this cube, click the Select whether the MPR cube overlay is visible icon
11. (Optional) To reset the zoom, pan, and orientation of an image in all viewports, click the Reset zoom, pan and orientation
of all views icon

.

Related topics:
• Performing and managing registration of images
Topics describing the registration of two images and the management of relationships between images.
• Findings
Topics describing the creation and editing of regions and rulers.
• The user interface
An overview of the user interface.
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Viewing a maximum intensity projection (MIP)
Summary: You can view a maximum intensity projection of your dataset.

About
Using the XD application, you can produce and view a maximum intensity projection (MIP) to view an apparently threedimensional representation of the data.
Warning: The Maximum Intensity Projection or MIP Renderer is a tool for data visualization in 3D and is
useful for obtaining an overview of the areas within the image data of a high intensity and as a tool to
navigate to those regions. The MIP should not be used as the sole view used to interpret the image data.

Procedure
To create and view a maximum intensity projection, complete the following steps:

1. Click the Display the series in the selected view as a MIP in a floating window icon

. A new window opens, displaying

the MIP.

2. Use the slider on the left of the window to rotate the direction from which the projection is taken.

3. To snap the view to the sagittal orientation, click the Snap to sagittal orientation icon

4. To snap the view to the coronal orientation, click the Snap to coronal orientation icon

5. To display a cine of the MIP rotating, click the Start cine icon

.

6. To pause a playing cine of the MIP, click the Pause cine icon

.

7. To reverse the direction in which the MIP rotates, click the Change direction of cine icon

.

.

.

8. To toggle between rotating the MIP through 360° (rotating) and rotating through 180° then reversing (flicking), click the
Toggle between rotation and flick icon,

when the image is currently rotating, or

when the image is currently

flicking.

9. You can also use the Image menu to manipulate the MIP as you would a normal viewport.
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Related topics:
• Exporting a maximum intensity projection (MIP)
You can export a maximum intensity projection.
• Viewing cines
A cine displays a series of image frames or slices in order.
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Capturing an image
Summary: You can capture views for later reference or for use outside of XD.

About
You can capture secondary images within the XD application that you can refer to later, after making other changes to the
dataset, or that you can use outside of the application.

Procedure
To capture an image and view this secondary capture within the application, complete the following steps:

1. You can capture a single viewport or a row or column of viewports.
• To capture a single viewport, complete the following steps:

i. On a layout screen, click the Take snapshot of views icon

.

Tip: The Take snapshot of views icon is also available in the right-click menu.

ii. Click a viewport. The viewport is captured, including all active text.
Tip: To capture the entire application window instead of a single viewport, press
Ctrl+Shift+E

• To capture a row or column, complete the following steps:
i. Select a viewport.
ii. Click the Edit menu and select either Capture row view or Capture column view. All viewports in the
row or column, respectively, of your selected viewport are captured and stored as a single secondary
capture.

2. To view a secondary capture, select the capture in the Image Gallery in the toolbox, and then click the Switch to the
secondary capture screen icon

. The Secondary capture screen opens.

3. To return to your layout, click Back to Layouts or, in the upper-right corner of the window, click Secondary Capture and
then select the layout you want to return to.
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4. (Optional) To delete one or more captures, select the capture or captures in the Image Gallery section of the toolbox and
then click the Remove selected images from the gallery icon

. You can select multiple captures by holding the Shift or

Ctrl keys.

Related topics:
• Exporting data
Export data for use outside of your session.
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Choosing a layout
Summary: Select the layout of images with which you want to view your data.

About
In XD, you can select from a number of different layouts, each of which will arrange images from a dataset in a different
manner. Each review mode features several layouts and you can also create your own custom layouts.

Procedure
To choose or change between layouts, use one of the following methods:
• In the upper-right corner of the application window, click the View button. The appearance of this button depends on your
current view, but will be one of the following:
◦ Data QC
◦ Registration Manager
◦ Findings Table Report}
◦ Secondary Capture
◦ The name of your current layout, for example, 1 Dataset - All Orientation
Then click the layout that you want to change to.

• Click the Window menu in the menu bar at the top of the application window and then select the layout that you want to
change to.
• Hold the Ctrl key and then cycle through available views, including layouts, by pressing the Tab key.

Related topics:
• Creating custom layouts
You can create custom layouts for viewing a study.
• Launching XD review modes
Launch the XD application.
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Interacting with active text
Summary: Blue text on an image is active text and can be used to manipulate the image.

About
In XD, two kinds of text are displayed on images. Blue text represents active text, and can be altered to change how the image
is displayed, while black or white text, whose color depends upon the colormap in use, is static and for information only.

Procedure
To manipulate an image by using its active text, complete the following series of steps:
• To edit the scale, complete the following steps:
1. In the upper-right corner of the image viewport, click the blue text Scale a:b, where a and b represent the current scale of
the image.
2. Use the slider to choose a new scale.
3. (Optional) Click Zoom to Fit to change the scale so that the entire image is displayed in the viewport.
4. Click Close.

Note: The change in scale will apply to linked views as specified in the Zoom Bindings section of the Image
menu. For more information, see Manipulating images.

• To change the window and level settings, complete the following steps:
1. In the upper-right corner of the image viewport, click the blue text *W = *X L=Y *, where *X and Y represent the current
window and level respectively.
2. In the Window and Level section of the Visualization window, specify the window and level that you want to use.
• If you want to specify values for your window and level, select Custom and specify a value for window, W, and
level, L.
• If you are using Hounsfield Units and want to use a common window and level, select it from the list.
• You can save a window and level combination for later use by providing a name in the field below W and L and
clicking the Save Range icon

.

3. Click OK.

Note: You can also use the sliders at the bottom of the Visualization window to set a custom window and level.
For more information about using the sliders, see Manipulating images.

• To edit the quantification options being used, complete the following steps:
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1. In the lower-left corner of the image, click the blue text X Units where X is the intensity of the image at the crosshairs and
Units is the units of that intensity.
2. Select the units that you want to use.
3. (Optional) If it is available, click Quantification Options, provide additional information, and click OK in the Quantification
Parameters window.
4. Click OK.
• To change which slice index you are viewing, complete the following steps:
1. In the lower-right corner of the image, click the blue text Slice x/y (z) where x is the current slice index, y is the total
number of slices, and z is the index of the current slice if the counting order is reversed.
2. Enter a new slice index within the available range.

Related topics:
• Customizing XD
Topics describing the customization of XD.
• Findings
Topics describing the creation and editing of regions and rulers.
• Manipulating images
Adjust your view of an image.
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Viewing cines
Summary: A cine displays a series of image frames or slices in order.

Prerequisites
To complete this task, you must have loaded into the application a dataset containing a time series or a three-dimensional
volume.

About
In XD, you can view images as a cine if they are either a time series or a three-dimensional volume. As a cine, the image
frames or slices are displayed sequentially so that you can see how features change with time or space. You can also control
the speed and direction of the cine.

Procedure
To view a cine, complete the following steps:

1. Select the viewport containing the orientation that you want to use for the cine.

2. In the Cine section of the toolbox, select Slices or Datasets depending on whether you want your cine to display different
spatial slices or datasets captured at different times.
3. Click the Start cine icon

to start the cine. The cine plays in all viewports, but when viewing slices only the selected

orientation’s image will change, while other orientations’ crosshairs will move appropriately.
Warning: The frames in a dynamic flow study are played at a uniform rate and not in real-time.

4. (Optional) Click the Change direction of cine icon

5. (Optional) Click the Pause cine icon

to reverse the order in which the cine plays.

to pause the cine.

6. (Optional) Use the slider in the Cine section of the toolbox to adjust the rate at which the cine plays or changes slice.

Related topics:
• Manipulating images
Adjust your view of an image.
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Performing and managing registration of
images
Summary: Topics describing the registration of two images and the management of relationships between images.

About
Images can be registered to one another within and between time points and datasets. You can perform registration
automatically or manually.

Topics in this section:
• Managing data bindings
You can create, remove, and edit bindings between datasets and between time points.
• Performing automatic registration
Have XD perform registration of two images.
• Performing manual registration
If you want to control registration beyond using an automatic algorithm, you can perform manual registration.
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Managing data bindings
Summary: You can create, remove, and edit bindings between datasets and between time points.

About
While XD creates data bindings automatically, these may not be correct and may require action.
A timepoint or dataset can be bound to one or more other timepoints or datasets. One-to-one bindings might be appropriate
between two gated sets of data; all-to-one bindings might be appropriate between gated data and a static volume; and two-toone bindings might be appropriate when two sets of gated data were sampled with different frequencies.
Data bindings have several effects:
• Changes made to ROIs in one dataset will be applied in other datasets that are bound to it, according to transformations.
• When viewing images, navigating through slices or timepoints in one dataset will navigate through slices or timepoints in the
dataset to which it is bound.

Procedure
To view and modify data bindings, complete the following steps:

1. Click the Tools menu and select Data Management. The Data Management screen is displayed.
Datasets are displayed as individual rows, while timepoints within a dataset are displayed as segments of a row.
Bindings between data are represented by lines joining timepoints or datasets. A dotted line indicates a binding between
datasets where it is not possible to draw the line without crossing a third dataset.

2. To remove a binding, right click the link and select Remove Binding.

3. To create a binding, click one of the two datasets or timepoints and drag to the other dataset or timepoint.

4. (Optional) To cycle the display through timepoints within a dataset, click the Cycle icons

. Doing so does not affect

the order of the data, but can be useful for viewing bindings that do not line up simply.

5. Each dataset with mutliple timepoints has an anchor volume. This is the timepoint that is used for registration between
datasets. The anchor volume is denoted by the Anchor icon

.

To change the anchor volume, right click the timepoint that you want to become the anchor volume and select Set as
Anchor.

6. (Optional) To revert all bindings to the automatically assigned bindings, click Reset Links.
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Related topics:
• The user interface
An overview of the user interface.
• Manipulating images
Adjust your view of an image.
• Findings
Topics describing the creation and editing of regions and rulers.
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Performing automatic registration
Summary: Have XD perform registration of two images.

About
XD is able to perform automatic registration by using various algorithms. The registration can be between time points,
modalities, or both. In this manner, you can quickly register images in a study.

Procedure
To perform automatic registration, complete the following steps:

1. Click the Registration menu and select Registration Manager.

2. In the pane at the top of the window, relationships between different images are displayed as lines between the roles of the
images.
Black lines between roles indicate that the images share a frame of reference and are hardware locked in their registration.
Images that are hardware locked to a reference image are also denoted by the Locked icon

and red lines between roles

indicate that the images are subject to a rigid registration. Columns of images represent different time points.
To expand a time point and display additional volumes contained within the time point, click the column header of a time
point, for example Current or Baseline. In the expanded view, click Back to return to the main view.
If the relationship that you want to register is locked, click the role and select Unlock Image, where Image is the name of the
non-reference image.
If you want to change the relationships, use the Data Management page. For more information, see Managing data bindings.

3. Click one of the roles that you want to register and select Role 1 -> Role 2 , where the Roles are the data roles that you
want to register. Views for each orientation are displayed with one image overlain on the other.

4. Perform one of the following registration types:
• To perform automatic rigid registration, in the Automatic Registration section of the toolbox, click Automatic
Rigid. To change the granularity with which the algorithm is run, click … beside Automatic Rigid and select the
granularity that you want to use.
Note: The granularity affects the quality of the registration and the time taken to perform it, with the
Fine registration taking longest. The registration runs automatically when you select a granularity.

• To perform deformable registration between two CT images, in the Automatic Registration section of the
toolbox, click CT Deformable. To change the granularity with which the algorithm is run, click … beside
Automatic Rigid and select the granularity that you want to use.
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Note: The granularity affects the quality of the registration and the time taken to perform it, with the
Fine registration taking longest. The registration runs automatically when you select a granularity.

Tip: For two CT images that were acquired from different scanners, or for images where only one of
the two is contrast enhanced, use the CT-CT algorithm for multi-modal registration, as detailed in
the next step.

• To perform deformable registration between any two images, in the Automatic Registration section of the
toolbox, click Multi-Modal Deformable. To select a registration algorithm that is tailored to your registration case,
click … beside Multi-Modal Deformable and select one of the following options:
▪ Default
A generic algorithm that works well for a variety of multi-modal registration cases
▪ CT-PET Emission
An algorithm optimized for CT-PET registration. Compared to the Default algorithm, it has tighter
constraints on transformation smoothness to ameliorate the weaker structural information present in
the PET.
▪ CT-MR
An algorithm optimized for CT-MR registration. Compared to the Default algorithm, it is slower but
gives more accurate registrations.
▪ CT-CT
An algorithm optimized for CT-CT registration where the images have been acquired from different
scanners, or where only one of the two images is contrast enhanced.
▪ CT-CBCT
An algorithm optimized for registration from a planning CT to a conebeam CT.
▪ MR-MR
An algorithm optimized for registering two MR scans.

Note: The registration runs automatically when you select an algorithm.

5. (Optional) To smooth a deformation so that displacements do not vary significantly between two near points, in the
Automatic Registration section of the toolbox, click Smooth Deformation.

6. Use the following tools from the Visualization Tools section of the toolbox to review the registration. You can also use the
standard image tools described in Manipulating images.
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• The left tool provides an overlay that represents the displacement arising from the registration. You can use one
of the following overlays:
▪ Show Displacement Map
Displays a heat map representing displacement.
▪ Show Displacement Grid
Displays a grid that is deformed and displaced in the same manner as the image.
▪ Show Displacement Arrows
Displays arrows showing the direction and scale of displacement at a given point.

• The middle tool allows you to display one image through a window instead as a transparent overlay. You can use
the following window types:
▪ Checkerboard
Displays the overlay and the base image in alternating squares.
▪ Inset
Displays the overlay as a single square in the center of the view. The middle tool also enables the
Overlay size slider, which you can use to adjust the size of the window.

• The right tool is the Show Displacement Value tool

, which toggles the display of the displacement at the

crosshairs on your image.

Warning: When an automatic registration scheme is run with data assignments containing multiple
related series (e.g. Gated CT or PET, Multi-phase CT, Multi-sequence MR), the first series/volume
assigned is the one used for registration for registrations involving that assignment. This may or may not be the
optimal series/volume to use for registration depending on the acquisition protocol. This can be modified on the
Data Management screen by changing the ‘Anchor’ for the assignment and reviewed on the Registration ->
Registration Manager to ensure that the registrations are satisfactory.

Next actions
If you want to alter your registration, you can do so manually. For more information, see Performing manual registration.

Related topics:
• Manipulating images
Adjust your view of an image.
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• Managing data bindings
You can create, remove, and edit bindings between datasets and between time points.
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Performing manual registration
Summary: If you want to control registration beyond using an automatic algorithm, you can perform manual registration.

About
You can perform manual rigid registration either by translating an overlay image yourself or by placing landmarks that are then
used to find a rigid transformation.

Procedure
To perform manual registration, complete the following steps:

1. Click the Registration menu and select Registration Manager.

2. In the pane at the top of the window, relationships between different images are displayed as lines between the roles of the
images.
Black lines between roles indicate that the images share a frame of reference and are hardware locked in their registration.
Images that are hardware locked to a reference image are also denoted by the Locked icon

and red lines between roles

indicate that the images are subject to a rigid registration. Columns of images represent different time points.
To expand a time point and display additional volumes contained within the time point, click the column header of a time
point, for example Current or Baseline. In the expanded view, click Back to return to the main view.
If the relationship that you want to register is locked, click the role and select Unlock Image, where Image is the name of the
non-reference image.
If you want to change the relationships, use the Data Management page. For more information, see Managing data bindings.

3. Click one of the roles that you want to register and select Role 1 -> Role 2 , where the Roles are the data roles that you
want to register. Views for each orientation are displayed with one image overlain on the other.
4. In the Manual Registration section of the toolbox, choose how to display your images by performing one of the following
actions:
• To view your images in a single view per orientation, click Fused.
• To view your images in two views per orientation, where one view displays both images and the second view only
the overlay, click Landmarks.
5. Perform manual registration by completing one of the following sets of steps:
• To perform manual rigid registration, complete the following steps:
i. Click Manual Rigid.
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ii. In the view of your overlain images, drag the overlay into the correct position.

• To perform registration based on landmarks, complete the following steps:
i. If it is not active, click Place Landmarks.
ii. In a view in the top row of views, click where you want to place a landmark on the base image.
iii. In a view in the bottom row of views, click where you want to place a landmark on the overlay image.
Place several landmarks and be careful to place a landmark on each image before placing the next
landmark.
iv. (Optional) To delete a landmark, select the landmark in the Marker pane in the Manual Registration
section of the toolbox, and then click Delete.
v. (Optional) To move the crosshairs to a landmark, select the landmark in the Marker pane in the
Manual Registration section of the toolbox, and then clcik Go To Source to move your crosshairs in
the source image, or Go To Target to move your crosshairs in the target image.
vi. When you have placed your landmarks, click Landmark Rigid to run the rigid registration.

6. Use the following tools from the Visualization Tools section of the toolbox to review the registration. You can also use the
standard image tools described in Manipulating images.
• The left tool provides an overlay that represents the displacement arising from the registration. You can use one
of the following overlays:
▪ Show Displacement Map
Displays a heatmap representing displacement.
▪ Show Displacement Grid
Displays a grid that is deformed and displaced in the same manner as the image.
▪ Show Displacement Arrows
Displays arrows showing the direction and scale of displacement at a given point.

• The middle tool allows you to display one image through a window instead as a transparent overlay. You can use
the following window types:
▪ Checkerboard
Displays the overlay and the base image in alternating squares.
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▪ Inset
Displays the overlay as a single square in the center of the view. The middle tool also enables the
Overlay size slider, which you can use to adjust the size of the window.

• The right tool is the Show Displacement Value tool

, which toggles the display of the displacement at the

crosshairs on your image.

Related topics:
• Manipulating images
Adjust your view of an image.
• Managing data bindings
You can create, remove, and edit bindings between datasets and between time points.
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Findings
Summary: Topics describing the creation and editing of regions and rulers.

About
Findings can be either regions or rulers and can be created manually or by segmenting your volume. Additionally, you can
project and link findings across datasets and time points.

Topics in this section:
• Segmenting an image
XD can perform automatic segmentation within an area that you define.
• Drawing a region
You can drawn a region on an image using the freehand region tool, or as an ellipse or rectangle.
• Editing a region
You can edit the properties, location, and size of a region.
• Creating and editing rulers
You can create permanent and temporary rulers and measure angles.
• Creating a ruler from a region
You can create a bi-ruler from a region.
• Annotating an image
Add annotations to an image that are included in the DICOM dataset.
• Linking findings together
You can link findings to indicate a relation between the two.
• Projecting findings
You can project and propagate findings between different images instead of creating each one separately.
• Creating multiple threshold regions
You can create multiple regions within another region, where each new region is contoured based on a specific threshold
level.
• Creating quantification volumes
Create a cylindrical or spherical region with a specific volume.
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Segmenting an image
Summary: XD can perform automatic segmentation within an area that you define.

About
XD provides several different tools for performing automatic segmentation. You can segment based on an absolute threshold,
a percentage of maximum threshold, using Hounsfield units in a CT scan, or from a seedpoint.

Procedure
To perform automatic segmentation of a volume, complete the following steps:
1. Click one of the following icons in the tool bar at the top of the window, depending on which tool you want to use. The tool
you want to use might not be displayed, in which case use the drop down menu beside whichever of these icons is
displayed. Alternatively, all the tools can be accessed through the Quantify menu.

• Use the Region with absolute threshold tool

to generate a region based on an absolute threshold that is set

in your contouring preferences. You can adjust the threshold within the bounding region later. For more
information about setting the initial threshold, see Setting user preferences.

• Use the Region with % max tool

to generate a region based on a threshold derived from a percentage of the

maximum intensity in the image. You can adjust the threshold within the bounding region later. For more
information about setting the initial threshold, see Setting user preferences.

• Use the Seedpoint Region tool

to generate a region from a seedpoint and grow that region.

• (CT image only) Use the CT Region Segmentation tool

to create a region that is segmented based on

mutual information. Click and drag to create two concentric spheres, where the inner sphere approximates the
region you want to segment. When you release the mouse button, the segmentation runs.

• (CT image only) Use the Adaptive CT Region Segmentation tool

to create a region that is segmented

based on mutual information, taking into account your current Window/Level settings. Click and drag to create two
concentric spheres, where the inner sphere approximates the region you want to segment. When you release the
mouse button, the segmentation runs.
Warning: The CT Region Segmentation tools estimate a lesion boundary based on image
contents and the user initialization and does not attempt any automated detection of lesions.
The quality of the results need to be checked for accuracy by the user prior to being used.
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2. If you are using the Seedpoint Region tool, click the location from which you want to grow your region.
Tip: If you want to transfer a region from one image volume to another, either within or across timepoints, you
can use the projection tools. For more information, see Projecting findings.

3. If you are using another tool, click and drag to create the 3D volume within which segmentation will be performed. In the
orientation that you are drawing the region on, the volume is drawn from corner to corner, while in other orientations the slice
you are drawing on will be treated as the center.
4. Complete the following fields:
• In the Name field, enter the name of the region, or select a standard region name from the drop down menu.
• In the Description field, enter a description of the region.
• Click the Color panel to select the color in which the region should be displayed.
• Use the check boxes to specify whether the region is a lymph node and whether it should be quantified.
• From the Interpreted Type drop down menu, select a type of region.
• In the Interpreter field, provide the name of the interpreter.
5. Click OK.
6. In the Threshold Settings section of the Toolbox, adjust your threshold settings by completing the following steps:
a. Use the Threshold by drop down menu to select the units that a threshold uses.
b. Use the numeric fields to specify percentages or absolute values for your upper and lower thresholds (according to what
you selected in the Threshold by field) or use the sliders to specify the range. The region updates dynamically as you
adjust your range.

Next actions
If you want to edit your region with other tools, see the Editing a region topic.
For information about using your new region for quantification, see Quantification.
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Drawing a region
Summary: You can drawn a region on an image using the freehand region tool, or as an ellipse or rectangle.

About
As well as using automatic segmentation and generating volumes, you can draw a 2D or 3D region on an image manually.

Procedure
To draw a 2D region on a single slice or a 3D region with its center on the current slice, complete the following steps:
1. Draw your region by using one of the following methods:
• To draw your region as either an ellipse or a rectangle, complete the following steps:

i. Click the Ellipse Region

or the Rectangle Region

icon depending on which type of region

you want to create.
If another region tool has been used more recently, use the drop down menu to select the appropriate
tool instead.
Alternatively, you can select either the Ellipse Region tool or the Rectangle Region tool from the
Quantify menu.

ii. In the position that you want to start, click the orientation and slice on which you want to draw a 2D
region and drag the cursor across to create the region. The ellipse region’s extremes in the vertical
and horizontal directions are defined by where you drag your cursor.

• To use the freehand tool to draw your region, complete the following steps:

i. Click the Freehand Region icon
If the Paint

or Erase

in the toolbar at the top of the window.

tool was used more recently, use the corresponding menu to select the

Freehand Region tool.
Alternatively, you can select the Freehand Region tool from the Quantify menu.

ii. Click on the orientation and slice where you want to start drawing your 2D region and drag the cursor
across the image in the shape of your region. The region will always be completed by a straight line
joining the start and your cursor. If you are not satisfied with your first attempt, you can draw the region
again or you can edit the region later.
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iii. Press Esc to exit the drawing tool.
iv. In the Findings section of the toolbox, double-click your newly created region.

• To create a 3D region, complete the following steps:

i. Click the Region icon

in the toolbar at the top of the window.

If another region tool has been used more recently, use the drop down menu to select the appropriate
tool instead.
Alternatively, you can select the Region tool from the Quantify menu.

ii. Select the slice that you want to use as the center of the sphere or cuboid.
iii. Click and drag to create the region.
Note: You can alter whether the Region tool creates a sphere or cuboid through the
Options window. For more information, see Setting user preferences.

Tip: If you want to transfer a region from one image volume to another, either within or across
timepoints, you can use the projection tools. For more information, see Projecting findings.

2. Complete the following fields:
• (Required) In the Name field, enter the name of the region, or select a standard region name from the drop down
menu.
• In the Description field, enter a description of the region.
• Click the Color panel to select the color in which the region should be displayed.
• Use the check boxes to specify whether the region is a lymph node and whether it should be quantified.
• From the Interpreted Type drop down menu, select a type of region.
• In the Interpreter field, provide the name of the interpreter. Click OK.

Mirada Medical, XD 3.6.11 Help Guide - mm8670-3.6.11-0

58

Next actions
If you want to edit your region with other tools, see Editing a region.
For information about using your new region for quantification, see Quantification.
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Editing a region
Summary: You can edit the properties, location, and size of a region.

Prerequisites
To complete this topic, you must first have created a region. For more information, see Segmenting an image or Drawing a
region.

About
Segmentation can be imperfect, or it can be easier to edit a region projected from a previous timepoint than to draw or
segment a new region. XD provides tools for editing regions.

Procedure
To edit a region, complete the following steps:

1. In the Findings section of the toolbox, or in a view, select the region that you want to edit.
2. To remove an area from a region, complete the following steps:
a. Click the Erase tool

in the toolbar at the top of the window. Alternatively, you can access it through the Quantify menu

or through the keyboard shortcut by pressing W.
b. Adjust the size of your eraser by using the Brush and Depth (%) sliders in the Region Editing Tools section of the
toolbox. You can also adjust the diameter by holding the Shift key and using your scroll wheel.
c. Erase a part of a region by clicking and dragging in that region. The eraser will have no effect outside of the selected
region and erases as a three-dimensional cylinder.
3. To add an area to a region, complete the following steps:
a. Click the Paint tool

in the toolbar at the top of the window. Alternatively, you can access it through the Quantify menu

or through the keyboard shortcut by pressing Q.
b. Adjust the size of your paint brush by using the Brush and Depth (%) sliders in the Region Editing Tools section of the
toolbox. You can also adjust the diameter by holding the Shift key and using your scroll wheel.
c. Add a part of the image to the region by clicking and dragging on the image. The paintbrush will have no effect inside the
selected region and paints as a three-dimensional cylinder.

Tip: If you want to transfer a region from one image volume to another, either within or across timepoints, you
can use the projection tools. For more information, see Projecting findings.

4. (Optional) To delete a region, ensure the region is selected and then click the Delete the selected findings icon

in the

Findings section of the toolbox.
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Related topics:
• Drawing a region
You can drawn a region on an image using the freehand region tool, or as an ellipse or rectangle.
• Segmenting an image
XD can perform automatic segmentation within an area that you define.
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Creating and editing rulers
Summary: You can create permanent and temporary rulers and measure angles.

About
XD provides the facility to create rulers on your images. Standard one-dimensional rulers can be permanent or temporary,
while two-dimensional rulers and angle measures are always permanent, though can be deleted.
These rulers are considered findings and can be used for quantification purposes.

Procedure
To create and edit rulers, complete the following steps:
1. In the top toolbar, click one of the following tools according to what you want to do. If a different tool was used more recently,
the tool you want to use might not be visible immediately; if this is the case, select the tool from the drop down menu beside
one of the other tools. All of these tools are also available through the Quantify menu.
• Use the Temporary Ruler tool

• Use the Ruler tool

• Use the 2D Ruler tool

• Use the Angle tool

to draw a ruler that is only displayed while you hold the mouse button.

to draw a persistent ruler.

to draw a persistent two-dimensional ruler.

to create a persistent angle measurement.

2. Click the image and drag to create the ruler. The angle or length is displayed. Release to complete the ruler or, if you are
using the temporary ruler tool, to remove the ruler.
3. (Persistent rulers only) Complete the following fields:
• (Required) In the Name field, enter the name of the ruler, or select a standard finding name from the drop down
menu.
• In the Description field, enter a description of the ruler.
• Click the Color panel to select the color in which the ruler should be displayed.
• Use the check boxes to specify whether the ruler is a lymph node and whether it should be quantified.
• From the Interpreted Type drop down menu, select a type of ruler.
• In the Interpreter field, provide the name of the interpreter.
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4. (Persistent rulers only) Click OK.

5. (Persistent rulers only) To edit a ruler, click and drag the anchor points on the ruler to rotate and click the ruler itself to
translate. When editing the angle tool, the anchor that does not have the angle displayed next to it can be used to change
the angle, while other anchors move the ruler.
6. (Optional) To delete a ruler, ensure the ruler is selected and then click the Delete the selected findings icon

in the

Findings section of the toolbox.

Warning: When defining a 2D ruler, the measurement associated with a line is displayed in the same
color as the line to which it pertains. When the measurements are similar, the colors should be checked to
identify the pertaining line.

Related topics:
• Quantification
Topics describing the use of XD features to perform quantification.
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Creating a ruler from a region
Summary: You can create a bi-ruler from a region.

About
Bi-rulers can be created from a region, identifying the long and short axes in the orientation in which they were created.

Procedure
To create a ruler from a region, complete the following steps:
1. In the Findings section of the toolbox, select the region from which you want to derive a ruler.
2. Right click the region and select Create Ruler from Region. A ruler is created.

Warning: The Create Ruler from Region tool calculates the long and short axes from the ROI selected
using mathematical approximations of the smooth ROI boundary. However, the resulting bi-ruler may not
correspond to what the user considers to be the long and short axes that best characterize the lesion from a
clinical point of view. It is important that the resulting Biruler is visually inspected and compared with the region
used for creation to ensure the results are as desired.

Warning: The Create Ruler from Region tool uses mathematical approximations to the smooth ROI
boundary when calculating the best bi-ruler placement. However, in some rare cases the approximations
may result in a ruler that does not correspond exactly to the displayed boundaries or one that passes slightly
outside the lesion boundary. The user should check the result of the tool to confirm that the ruler meets their
expectations.

Related topics:
• Creating and editing rulers
You can create permanent and temporary rulers and measure angles.
• Performing RECIST
Perform RECIST evaluation of solid tumors.
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Annotating an image
Summary: Add annotations to an image that are included in the DICOM dataset.

About
In XD, you can add annotations to images to draw attention to features or provide information.

Procedure
To annotate an image, complete the following steps:

1. Right click the view and select the Create an annotation tool

. You can also access the tool by clicking the Quantify

menu and selecting Annotation, or through the drop down menu containing other ruler tools.
2. Click the image and drag to create a line, which indicates to what the annotation pertains. The text is positioned at the end
where you release the mouse button.
Note: The annotation only exists in the slice and orientation in which it is drawn, it is not visible elsewhere.

3. In the Text field, enter or select the text of the annotation.

4. (Optional) Use the Color panel to select the color in which you want the annotation to be displayed.
5. Click OK to save the annotation, or click Cancel to redraw the annotation.

Related topics:
• Manipulating images
Adjust your view of an image.
• Creating and editing rulers
You can create permanent and temporary rulers and measure angles.
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Linking findings together
Summary: You can link findings to indicate a relation between the two.

Prerequisites
To complete this task, you must have first created at least two findings. You must have two regions on the same data role but
in different datasets or time points, two rulers, or a ruler and a region.
For more information about creating findings, see the following topics:
• Segmenting an image
• Drawing a region
• Creating and editing rulers

About
To calculate certain statistics, you need to link one or more findings together. When linked, two findings are treated as a single
finding that can be separated later.
You can link findings in the following circumstances:
• You can always link two rulers
• You can always link a region and a ruler
• You can link a region to another region that is drawn on the same role but on a different dataset
• You can link a region to another region that is drawn on the same role but on a different time point
You cannot link a region to a region when they have a different role, or when they share both a time point and a dataset.

Procedure
To link two findings together, complete the following steps:

1. In the Findings section of the toolbox, select the findings you want to link. Select multiple findings by holding the Shift or
Ctrl keys. You can link two or more findings.

2. Click the Link the selected findings icon

. The findings are linked and use the name of the last selected finding in the

list.

3. (Optional) To remove the link between findings, and to separate the findings again, right-click the combined finding and
select Unlink. The separated findings all use the name of the combined finding.
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Related topics:
• Segmenting an image
XD can perform automatic segmentation within an area that you define.
• Drawing a region
You can drawn a region on an image using the freehand region tool, or as an ellipse or rectangle.
• Creating and editing rulers
You can create permanent and temporary rulers and measure angles.
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Projecting findings
Summary: You can project and propagate findings between different images instead of creating each one separately.

Prerequisites
To complete this task, you must have already created a finding and you must have multiple datasets or time points.

About
Instead of segmenting each image individually, you can project a finding from one image to one or more others.

Procedure
To project a finding, complete the following steps:

1. Findings can be projected across either time points or data roles, but not both simultaneously. For example, you can project
from a functional data role to another time point’s functional data role, but not to another time point’s anatomical data role.
To choose the data role from which you want to project, click a view that shows that data role. Fused views use the base
layer.

2. In the Findings section of the toolbox, select the finding or findings that you want to project.

3. Depending on the manner in which you would like to project your finding, use one of the following approaches, a list of
available projection methods can be found later in this topic.

• Two tools are available directly from the Findings section of the toolbox.

• The remaining tools are available through the context menu. Access the context menu by right-clicking the finding
that you want to project.

The region is reproduced in the other volumes that you specified and is linked to the original region.
Warning: When propagating ROIs between time points, it is important to check that the threshold used is
appropriate for the data in the time points. For meaningful comparison statistics to be displayed, the
threshold should be the same in each time point.
To see the threshold used, select the region in the time point and view the threshold slider or hover the mouse
over the Region defined in the Regions of Interest panel in the Toolbox. The threshold is also visible on the
Regions Table.
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Projection methods
The methods execute one of the three following actions upon a variety of targets:
• Project by type
Use the same method of creation, such as a seedpoint or threshold region, to generate the finding in the new volume.
• Transform
Use the same registration between volumes to transform the entire finding.
• Project by volume
Use a point to point registration between volumes to transform the location of the finding, but make no changes to size or
shape except to account for different voxel sizes.
The following volumes can be targeted:
• All
Target all roles and time points.
• Within time point
Target all volumes within the same time point (bins of a gated dataset, phases of a multi-phase CT, or sequences of multisequence MR)
• Current
Target the most recent time point.
• Remaining
Target all roles and times points that do not yet contain the finding.
• Remaining within time point
Target all volumes within the same time point that do not yet contain the finding.
The following table lists all available methods of projection:
The first three tools are available through the context menu.

Projection method

Action

Project to All by Type

Generate the finding in all time points in the same
manner as it was originally created

Transform to Current

Transform the finding by applying the same
transformation as is used for registration to the
whole finding

Project to All within Timepoint by Type

Generate the finding, in the same manner as the
original, in all volumes within the same time point

The following tools are available in the context menu only and not all are available by default. For information about making
them available, see Setting user preferences. To open the context menu, right click the finding.
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Project to All by Volume

Generate the finding in all time points by using a
transformation that preserves the finding’s shape
and volume while adjusting for changes in voxel
size

Transform to All

Transform the finding to all images occupying the
same role by using the same transformation as
used for registration

Project to Remaining by Type

Generate the finding in the same manner as the
original in all images that share the same role but do
not yet have the finding

Project to Remaining by Volume

Generate the finding in all time points that do not yet
contain the finding by using a transformation that
preserves the finding’s shape and volume while
adjusting for changes in voxel size

Transform to Remaining

Transform the finding to all time points that do not
yet contain the finding by applying the same
transformation as is used for registration to the
whole finding

Project to Current by Type

Generate the finding in the same manner as the
original in the most recent volume

Project to Current by Volume

Generate the finding in the latest time point by using
a transformation that preserves the finding’s shape
and volume while adjusting for changes in voxel
size

Project to All within Timepoint by Type

Generate the finding, in the same manner as the
original, in all volumes in the same time point (bins
of a gated dataset, phases of a multi-phase CT, or
sequences of multi-sequence MR)

Transform to All within Timepoint

Transform the finding to all volumes within the same
time point (bins of a gated dataset, phases of a
multi-phase CT, or sequences of multi-sequence
MR) by using the same transformations as used for
registration

Project to Remaining within Timepoint by Type

Generate the finding, in the same manner as the
original, in all volumes (bins of a gated dataset,
phases of a multi-phase CT, or sequences of multisequence MR) in the same time point that do not
already contain the finding

Transform to Remaining within Timepoint

Transform the finding to all volumes within the same
time point (bins of a gated dataset, phases of a
multi-phase CT, or sequences of multi-sequence
MR) that do not yet contain the finding, using the
same transformations as used for registration
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Warning: Regions resulting from performing the Transform to All, Transform to Remaining, Transform to
All within Timepoint and Transform to Remaining within Timepoint actions are highly dependent on the
quality of the registration that exists between the dataset on which the source region exists and all the datasets
to which the region is to be transformed. It is recommended that quality checks be performed within the
Registration Manager screen on the accuracy of the registrations prior to performing a region transformation
action.

Related topics:
• Segmenting an image
XD can perform automatic segmentation within an area that you define.
• Drawing a region
You can drawn a region on an image using the freehand region tool, or as an ellipse or rectangle.
• Creating and editing rulers
You can create permanent and temporary rulers and measure angles.
• Creating a ruler from a region
You can create a bi-ruler from a region.
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Creating multiple threshold regions
Summary: You can create multiple regions within another region, where each new region is contoured based on a specific
threshold level.

About
Multiple threshold regions are generated inside the same bounds within which another region was generated. Several findings
are created, each of which segments the volume using at several threshold levels, which can be configured in the Options
window.

Procedure
To create a set of multiple threshold regions, complete the following steps:
1. Create a new region. Click the Ellipse Region icon

in the toolbar, or use the keyboard shortcut Ctrl+L and then click

and drag over the area of an orientation in which you want to create multiple threshold regions. The Rectangle Region
tool can also be used.
Note: You can also use an existing region, in which case skip to step 4.

2. Complete the following fields:
• (Required) In the Name field, enter the name of the region, or select a standard region name from the drop down
menu.
• In the Description field, enter a description of the region.
• Click the Color panel to select the color in which the region should be displayed.
• Use the check boxes to specify whether the region is a lymph node and whether it should be quantified.
• From the Interpreted Type drop down menu, select a type of region.
• In the Interpreter field, provide the name of the interpreter.

3. Click OK.

4. In the Findings section of the toolbox, ensure that your region is selected.
5. Click the Create regions at preset thresholds within the selected area icon

.

You have created multiple threshold regions within your initially created region. You can alter the thresholds of each new
region individually by selecting the region and using the Threshold Settings section of the Toolbox.
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You can change the thresholds, delete thresholds, or add new thresholds in the Options window. For more information, see
Setting user preferences.

Related topics:
• Segmenting an image
XD can perform automatic segmentation within an area that you define.
• Quantification
Topics describing the use of XD features to perform quantification.
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Creating quantification volumes
Summary: Create a cylindrical or spherical region with a specific volume.

About
PERCIST requires the creation of regions with a specific volume, for use comparing different parts of the image volume. XD
provides the means to create these.

Procedure
To create a region with a fixed shape and volume, complete the following steps:

1. Place the crosshairs at the location in the image volume where you want to create the region. The crosshair location is used
as the center of the sphere or cylinder.

2. To place a region centered on the crosshairs, click the Quantify menu and then select one of the following tools:
• To place a cylindrical region with a diameter of 1cm, bevelled ends, and a total volume of 2cm3, select Drop 1cm
Diameter Cylinder.
• To place a spherical region with a diameter of 3cm, select Drop 3cm Diameter Sphere.
• To place a spherical region with a diameter of 1cm, select Drop 1cm Diameter Sphere.
• To place a spherical region whose diameter can be adjusted by holding the Shift key and using the scroll wheel,
slect Drop Volume Crosshair Sphere.
Note: You can adjust the diameter of the sphere only before placing it.

Related topics:
• Performing PERCIST
Use XD to perform PERCIST evaluation on lesions.
• Performing RECIST
Perform RECIST evaluation of solid tumors.
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Quantification
Summary: Topics describing the use of XD features to perform quantification.

About
You can view and export statistics from the findings table. Additionally, in this section you will find topics describing how to
perform PERCIST and RECIST evaluation.
Statistics supported by XD include metabolic tumor volume (MTV), total lesion glycolysis (TLG), RECIST, WHO and PERCIST.
For a description of the available statistics, see Statistics, Calculation of statistics for gated data and Derived statistics.

Topics in this section:
• Using the findings table
Use the findings table to view statistics calculated for various regions and rulers.
• Viewing a region intensity distribution
You can view bar charts comparing intensity distributions.
• Performing PERCIST
Use XD to perform PERCIST evaluation on lesions.
• Performing RECIST
Perform RECIST evaluation of solid tumors.
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Using the findings table
Summary: Use the findings table to view statistics calculated for various regions and rulers.

Prerequisites
To take full advantage of this task, you must have created at least one finding. For more information, see the Findings section.

About
The findings table displays the statistics available for your findings. It consists of several tabs, each of which groups a
particular type of statistics, and you can create and customize an Advanced tab.

Procedure
To use the findings table, complete the following steps:

1. Access the Findings table by clicking the View button at the top-right of the screen and selecting Findings Table or by
clicking the Window menu and selecting Findings Table.
The different tabs collate different types of statistics.
• The Intensity Distribution tab displays the intensity distribution values for all the categories of the current
intensity distribution definition.
• The PERCIST tab displays statistics relevant to PERCIST.
• The RECIST tab displays statistics relevant to RECIST.
• The Regions Tracking tab displays information pertaining only to regions and not to rulers.
• The WHO tab displays statistics specific to WHO and bi-rulers.
• The Advanced tab is customizable and displays the statistics that you choose through the Options window.
The different columns of the findings table provide the following information:
• The Finding Name column lists the name of the finding on which a statistic is based.
• The Lymph column details whether a finding is marked as a lymph node.
• The Dataset column lists the dataset from which a statistic is calculated.
• The Quantification column provides the value of the statistic
• The Unit column details the unit of the quantification column
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• The remaining columns represent the value of a statistic in a given time point or, for a tracking column, the
percentage difference of that time point to the value indicated by the top entry of the column.

Note: If you have drawn regions on multiple datasets, you can confirm which dataset a region was drawn on by
hovering your cursor over the region in the Findings section of the toolbox. The dataset on which is was drawn
is displayed at the top of the tooltip.

Note: If you calculate the same statistic for the same region on multiple datasets, it is possible that differing
image resolutions will result in the calculation of different values.

1. Click the tab that you want to view.

2. In the Settings section of the toolbox, use the Tracking Mode drop down menu to select the type of tracking used, where
Baseline compares the statistic to the baseline time point’s value, Waterfall compares it to the previous time point’s value,
and Min. to Date compares the statistic to the previous minimum.

3. In the Settings section of the toolbox, use the Dataset drop down menu to select the dataset that you want to use to
calculate statistics.

4. In the Findings section of the toolbox, use the check boxes for each finding to control which are displayed in the findings
table.
5. (Optional) To control which statistics appear in the findings table of the current tab, complete the following steps:
a. In the Settings section of the toolbox, click Options.
b. Use the check boxes in the Graph column to specify whether a graph is displayed for the finding. The All Graphs and No
Graphs buttons can be used to respectively select or deselect all the check boxes in the Graph column.
c. Use the check boxes in the Table column to specify whether a finding is displayed in the table. The All Tables and No
Tables buttons can be used to respectively select or deselect all the check boxes in the Table column.
6. (Optional) To take a visual snapshot of the findings table and save it as a secondary capture, click Snapshot Table.

7. (Optional) To copy the table to your system clipboard for later use in another application, click Copy Table.
8. (Optional) To copy or save a graph, right-click the graph and select Copy, to copy the graph to your system clipboard, select
Save as to save the graph as an image in your file system, or select Save to Image Gallery to save the graph as a
secondary capture.
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Related topics:
• Setting user preferences
Use the Options window to manage user preferences.
• Findings
Topics describing the creation and editing of regions and rulers.
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Viewing a region intensity distribution
Summary: You can view bar charts comparing intensity distributions.

About
By using defined intensity distributions, you can compare how much of a finding falls into particular categories in different time
points.

Prerequisites
To complete this task, you must have at least one intensity distribution definition configured for the imaging modality that you
want to use. For more information on defining an intensity distribution definition, see Setting user preferences.
You must also have at least one region present in at least one time point.

Procedure
To view a bar chart of region intensity distributions, complete the following steps:
1. In the Findings section of the Toolbox, select the single region that you want to view the intensity distribution of.
2. Click the Displays findings graphs icon

.

3. In the left pane, use the radio buttons to specify whether you want to view a single time point or all time points together.
4. (Single Timepoint only) Use the Select Timepoint drop down menu to select the time point for which you want to view a
graph.
The graph is displayed in the main pane of the window.
Warning: Depending on the regions used, it is possible that a region intensity distribution will not sum to
100%.
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Performing PERCIST
Summary: Use XD to perform PERCIST evaluation on lesions.

About
The XD application provides tools that can be used to perform PERCIST evaluation. While these tools are described
elsewhere in the user guide, this topic describes the particular steps needed for PERCIST.
This topic uses the PERCIST protocol as described in Practical PERCIST: A Simplified Guide to PET Response Criteria in
Solid Tumors 1.0 by Joo Hyun O, Martin A. Lodge and Richard L. Wahl.

Procedure
To calculate the PERCIST threshold using XD, complete the following steps:
1. To confirm and, if necessary, edit the properties used to calculate patient’s SUV Lean Body Mass, complete the following
steps:
a. In the lower left corner of a PET view, click the active text showing the units of the view. Alternatively, click the Image menu
and select Quantification Options.
b. In the Quantification Options window, click Quantification Options.
c. Check the Height and Sex fields are correct and, if necessary, correct them.
d. Click OK to save changes or Cancel to discard changes.
e. Select PET SUV from Lean Body Mass.
f. Click OK.
2. Place a reference region in your PET volume by performing one of the following sets of steps:
• If the patient’s liver is healthy, complete the following steps:
i. Use the pan and zoom tools to focus on the liver. For more information on the use of these tools, see
Manipulating images.
ii. Place the crosshairs where you want to center your reference region. Ensure that the crosshairs are
correctly positioned in all orientations.
iii. Click the Quantify menu and select Drop 3cm Diameter Sphere.
iv. If necessary, click the region and drag it to adjust its position.

• If the patient’s liver is not healthy, and there is a clear area in the descending thoracic aorta where a cylinder can
be placed, complete the following steps:
i. Use the pan and zoom tools to focus on the descending thoracic aorta. For more information on the
use of these tools, see Manipulating images.
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ii. Place the crosshairs where you want to center your reference region. Ensure that the crosshairs are
correctly positioned in all orientations.
iii. Select the coronal view.
iv. Click the Quantify menu and select Drop 1cm Diameter Cylinder.
v. If necessary, click the region and drag it to adjust its position.

• If the patient’s liver is not healthy, and there is no clear area in the descending thoracic aorta where a cylinder can
be placed, complete the following steps:
i. Use the pan and zoom tools to focus on the descending thoracic aorta. For more information on the
use of these tools, see Manipulating images.

ii. Click the Paint tool

in the toolbar at the top of the window.

If the Freehand or Erase tools were used more recently than the paint tool, use the drop down menu to
select the Paint tool. Alternatively, click the Quantify menu and select Paint.

iii. In the Region Editing Tools section of the Toolbox, use the Depth slider to specify the minimum
possible depth.
iv. In the coronal view, click in the descending thoracic aorta to place the first disc of the region. The
region is drawn only on the current slice.
Tip: You can hold the Ctrl key and use the scroll wheel to adjust the diameter of the
brush.

v. Move to the next slice and click again to place another disc. The discs are joined to form a contiguous
region. Repeat this step to build up a cylinder or near-cylinder.
To check that a region is the correct size, use the ruler tools. For more information, see Creating and
editing rulers.

vi. In the Findings section of the toolbox, double click your newly created region.
vii. In the Finding Name window, from the Name drop down list, select Reference.

Mirada Medical, XD 3.6.11 Help Guide - mm8670-3.6.11-0

81

3. Identify the hottest lesion on the PET volume and then segment it, using the threshold calculated in Step 2 and the Region
with Absolute Threshold tool

. For more information about the tool, see Segmenting an image.

4. In the Findings section of the toolbox, select your reference region and your areas of concern.

5. To track the identified lesion across time points, in the Findings section of the toolbox, right-click any of the regions and
select Project to All by Type, and then, in the toolbox, click the Projects the selected findings to all time points icon

.

Note: If Project to All by Type is not available in the context menu, you can enable it through the Findings tab
of the Options window. For more information, see Setting user preferences

6. Click the Show findings table icon

to open the findings table. Alternatively, click the Window menu and select

Findings Table.

7. Click the PERCIST tab. The table displays the percentage of change in tumor metabolism between the baseline and
subsequent image volumes.

8. (Optional) To customize your findings table, click Options in the toolbox. You can specify which statistics are included and
for which statistics graphs are created. For more information, see Using the findings table.
9. Export your findings table in one of the following manners:
• To export your findings table as an image, click Snapshot Table. The table is saved to your image gallery and
can be exported in the same manner as a normal image. For more information, see Exporting secondary
captures.
• To copy your findings table in another application, click Copy Table. Your table is available on your system’s
clipboard.

Related topics:
• Manipulating images
Adjust your view of an image.
• Findings
Topics describing the creation and editing of regions and rulers.
• Using the findings table
Use the findings table to view statistics calculated for various regions and rulers.
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Performing RECIST
Summary: Perform RECIST evaluation of solid tumors.

About
XD provides functions that are useful for performing RECIST evaluation, and the findings table in particular will quantify tumour
growth or shrinkage when findings are labelled appropriately.

Procedure
To use the XD application to perform RECIST evaluation, complete the following steps:
1. On your Anatomical volume in your Baseline time point, create contours around the tumours either by automatic
segmentation or by drawing the regions.
• To create a contour by automatic segmentation, complete the following steps for each tumour or refer to the
Segmenting an image topic:
i. In the toolbar, click the Region with absolute threshold
Region Segmentation

, Region with % of max

or CT

tool. These tools may be hidden under other segmentation tools, in which

case select them from the drop down menu. Alternatively, you can access them through the Quantify
menu.
ii. Navigate to the tumour in the orientation in which it is most easily visible. For more information, see
Manipulating images.
iii. Click the image and drag to define the volume in which the segmentation will be carried out. If the
threshold levels are not correct, you can change them as described in the Setting user preferences
topic.
iv. In the Name field, provide a name for your region.
v. If the region is a lymph node, click Lymph Node.
vi. (Optional) Fill out any additional fields that are part of your process.
vii. Click OK.

• To create a contour by using the Draw or Paint tools, complete the following steps for each tumour or see
Drawing a region.
i. In the toolbar, click the Freehand Region
another or the Erase tool

or Paint

tool. These tools may be hidden under one

, in which case select them from the drop down menu. Alternatively, you

can access them through the Quantify menu.
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ii. Navigate to the tumour in the orientation in which it is most easily visible. For more information, see
Manipulating images.
iii. If using the Paint tool, click and drag on the image where you want to create region in a sphere around
your cursor. Click a different viewport or select a different tool to complete the region.
iv. If using the Freehand Region tool, click and drag on the image and draw the outline of the region in a
single slice. Release the mouse button to complete the region.

v. In the Findings section of the toolbox, double click your region to open the Finding Name window.

vi. In the Name field, provide a name for your region.
vii. If the region is a lymph node, click Lymph Node.
viii. (Optional) Fill out any additional fields that are part of your process.
ix. Click OK.

2. In the Findings section of the toolbox, select your regions. Hold Ctrl to select multiple findings at once.
3. Click the Projects the selected findings to all time points icon

or right click the findings and select Project to all by

type. The findings are generated in all time points by using the same methods as you originally used.
4. Click Baseline in the upper-right corner of the window and select Current or Prior X depending on which time point you
want to correct the findings of.
5. For each region, select the region and use the Paint and Erase tools to correct them. For more information, see Editing a
region.

6. For each region, right click the region in the Findings section of the toolbox and select Create ruler from region to create a
bi-ruler in the currently selected orientation in all time opints.
7. Use the Layout button in the upper right corner of the window and select Findings Table or click the Window menu and
select Findings Table.
8. Click the RECIST tab. The details of your regions, including the the Long Axis and Short Axis measurements of the region,
are displayed. The BiRuler Auto statistic presents the Short Axis for a region marked as a lymph node and the Long Axis for
a region not marked as a lymph node.
To save time when you have additional time points to consider, use the projection tools. For more information, see Projecting
findings.
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Related topics:
• Findings
Topics describing the creation and editing of regions and rulers.
• Using the findings table
Use the findings table to view statistics calculated for various regions and rulers.
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Customizing XD
Summary: Topics describing the customization of XD.

About
XD is highly customizable. You can create custom layouts, assign hotkeys to specific functions, and alter a range of user
preferences.

Topics in this section:
• Setting user preferences
Use the Options window to manage user preferences.
• Creating custom layouts
You can create custom layouts for viewing a study.
• Assigning hotkeys
You can customize key bindings for XD functions.
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Setting user preferences
Summary: Use the Options window to manage user preferences.

About
XD provides a wide range of customization, much of it accessed through the Options window. These settings are managed on
a per-user basis, unless otherwise stated.
To open the Options window, click the Tools menu and select Options.
Click Apply to apply changes and keep the Options window open, OK to apply changes and close the Options window, or
Cancel to discard changes and close the Options window.

User Preferences
The following user preferences are available through the Options window:

Preference

Tab

Description

Data QC

For the selected image modality
or for patient information, specify
whether an item from the list is
visible in the Data QC screen
and whether it is subject to
validation checks.

Other Settings

Data QC

Specify whether the Data QC
screen is hidden, prompted for,
or displayed when launching the
application.

SCP Configuration

DICOM

Add, edit and remove DICOM
SCP details.

DICOM

Set the SCU AE title used for
exporting data. (Requires
administrative permissions)

Region Display

Findings

Specify how regions are
displayed, including shading,
outlines, transparency, and
whether a findings table is
displayed when hovering the
cursor over the finding.

Region type

Findings

Specify whether 3D regions are
ellipsoid or cuboid.

Default PET absolute threshold
and Default percentage threshold

Findings

The default thresholds for when
threshold regions are created.

Item

SCU Configuration
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Preference

Tab

Description

Findings

Specify whether views center on
new regions and whether
bounding boxes are drawn from
a vertex or from the center.

Findings

Specify whether when creating
new findings, the Finding Name
window is displayed. Click
Suggestions to configure the
names that are available from a
drop-down menu.

Findings

Specify the threshold values of
the boundaries between different
regions that are generated with
the Create Multiple Threshold
Regions tool.

Findings

Specify which options are
available in the context menu
when right-clicking a finding and
in the Findings section of the
toolbox.

Viewer Options

Quantification

For the selected modality, specify
which quantified values are
displayed in the annotation of a
finding.

Units

Quantification

Specify the units used for length
and volume measurements.

Quantification

Specify the tabs and default tab
of the Findings Table.
Additionally, specify how
timepoints are displayed in the
table.

Region Intensity Distribution

For the selected image modality,
create and manage intensity
distribution definitions and, for
some modalities, the
quantification method used when
presenting intensity distributions.
For more information, see
Viewing a region intensity
distribution

Center views on new region and
Draw bounding boxes from
center

Prompt for name of new finding

Multi-threshold region boundary
values

User Interface Settings

Findings Table

Intensity Distribution Definitions
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Preference

Tab

Description

Review Modes

Manage the availability of layouts
in each review mode, which
layouts are favorites and
displayed at the top of the
Toolbox, and default registration
schemes that are run when the
application is launched. You can
also set window and colormap
defaults.

Session

Specify whether prompts to save
are provided when exiting the
application of if the session is
saved automatically.

Session

Specify the behavior of the
application when saved sessions
are selected when launching the
application.

Session

Specify whether saved sessions
are exported as a single
secondary capture DICOM object
or as multiple objects.

User Interface Settings

User Interface

Specify whether or not, when
multiple application windows are
open, closing one window will
close all windows. Additionally,
select which tools and options
are available in the toolbar at the
top of the application window or
in the context menu, accessed
by right-clicking. For more
information about configuring
hotkeys, see Assigning hotkeys.

Startup Options

User Interface

Set a range of default settings for
when the application starts.

Views

Specify a range of settings for
how views appear. High contrast
borders affect the currently
selected view. Colored planes
indicate image planes by color.
Progress information indicates
how complete a registration is
while running.

Review Mode Settings

Save and Export

Restore Session

Compatibility Options

View Settings
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Preference

Tab

Description

Information Overlays

Views

Set font sizes and specify which
optional information is displayed
in a view. The font size of
interactive text is applied to all
text in the corners of views,
though the color applies to only
active text.

Slice numbering

Views

Specify the direction of slice
numbering.

Views

Specify what information is
displayed in a view or in a screen
capture of that view type. The
Default, Default Snapshot and
Patient Only settings provide
information on Patient Name,
Sex, Age, Date of Birth,
Institution Name, and Accession
Number. The Default and Default
Snapshot settings provide
information on Scale Label,
Window/Level Controls, Dataset
Name, Quantification, View
Code, View Type, Series Date,
and Series Description. The
Default, Default Snapshot and
Slice Number only settings
provide the Slice Number.

Window Level

Window Level

For the selected image modality,
configure the default settings
used when the application
launches, including whether
window/level settings defined in
the data are used or not.
Additionally, set hotkeys for
defined window/level settings.

General Options

Window Level

Specify between which images
window/level settings are linked
when the application launches.

Information Overlays
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Creating custom layouts
Summary: You can create custom layouts for viewing a study.

About
In addition to the supplied layouts in XD, you can create layouts specifically tailored to your needs.

Procedure
To create a custom layout, complete the following steps:

1. Click the Tools menu and select Layout Editor.
2. In the New Layout window, provide initial details about your layout:
Note: If you have begun editing a new layout and have not yet saved it, the New Layout window does not
open and instead the layout editor is opened on the in-progress layout. You can create a new layout by clicking
the Create a new layout icon

a. In the Layout name field, provide a name for your new layout.
b. From the Applicable for drop-down menu, select the review mode with which the layout can be used.
c. In the Number of timepoints field, specify the minimum number of timepoints that are required before the layout can be
used.
d. Click OK.

3. To choose the number of viewports in your layout, click the Select the grid dimensions for the layout icon

and adjust

the size of the grid that you want to arrange your viewports on.
4. (Optional) To merge one or more viewports, click the viewports and then right click either viewport and select Merge cells.
Deselect viewports by clicking them again.
Note: You can merge groups of cells only when they form a square or rectangle.

5. (Optional) To split previously merged viewports, right click the merged viewport and select Split cells.
6. Assign view types to your viewports by completing the following steps:
a. In the View Types section of the toolbox, from the Select Type drop down menu, select the type of view you want to
assign.
b. Click the view type in the toolbox and drag it across to the viewport in which you want to display it.
c. (Optional) To overlay different datasets, drag additional view types across to an occupied viewport.
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Note: You cannot overlay different types, orientations, or any 2D Slice and Planar Views.

Warning: Fused images are displayed within system provided layouts and can be included in user
defined layouts. The modality, quantification information, time point and dataset designation within the
current review mode are displayed for each layer in the fused view to allow identification of each layer.

Warning: When a layout image segment contains multiple planar NM Images from one or more series,
the only way to distinguish to which planar series an image pertains is by the series description text
label on the image segment.

Warning: Gallery images do not individually contain patient identification information due to the
potentially limited size of the image segments. To identify to which images the gallery pertains, system
provided gallery views contain a patient information view segment. The layout editor allows patient information
views to be added to all user defined layouts and should be used when creating Gallery views.

a. (Optional) To remove all assigned view types from a viewport, right click the viewport and select Remove assignment.
7. To customize default display options for a viewport, complete the following steps:
a. (Optional) To set a time point that should be used for the viewport, right click the viewport, select Set timepoint, and then
select the time point that you want to use.
b. (Optional) To assign an offset to which dataset should be displayed, right click the viewport, select Dataset Offset, and
then select the offset that you want to use. If you want to set an offset greater than 10, use the Custom option.
c. (Optional) To set a slice offset to the viewport, select Slice Offset, and then select the offset that you want to use. If you
want to set an offset greater than 10, use the Custom option.
d. (Optional) To specify the default window and level settings, right click the viewport, select Window/Level, and then select
one of the predefined settings.

8. Click the Save the layout icon

. You must have filled all your viewports before you can save.

9. Click This user to save the layout for only the current system user, or click All users to save the layout for all users of the
system. Depending on your user permissions, you might not be able to save for all users.

Related topics:
• Choosing a layout
Select the layout of images with which you want to view your data.
• Manipulating images
Adjust your view of an image.
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Assigning hotkeys
Summary: You can customize key bindings for XD functions.

About
Hotkeys in XD are highly configurable, many of the available functions can be assigned to new hotkeys, and existing hotkeys
can be changed to suit your preferences.

Procedure
To assign a function to a hotkey, or to edit an existing hotkey, complete the following steps:

1. Click the Tools menu and then select Options.

2. In the Options window, click the User Interface tab and then click Hotkey configuration…

3. Double-click the entry in the Hotkey column for the function that you want to assign a hotkey to or edit the hotkey of.

4. Press the hotkey, or the key combination, that you want to assign to the function.

5. (Optional) To remove a hotkey, select the entry and click Clear.

6. (Optional) To revert a hotkey to its default setting, select the entry and click Default.

7. (Optional) To revert a hotkey to its previous setting when you opened the window, click Revert.

8. Click OK.
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Saving, loading, and exporting data
Summary: Topics describing the saving, importing, and exporting of data from XD.

About
You can export DICOM, image, or table data for use in other applications. Additionally, you can save and load sessions.

Topics in this section:
• Saving a session
You can save your current session and return to it later.
• Loading a session
You can resume a previous XD session.
• Exporting data
Export data for use outside of your session.
• Exporting a maximum intensity projection (MIP)
You can export a maximum intensity projection.
• Creating a DICOM viewer
You can create a folder containing everything needed to view your currently loaded images.
• Creating a report
Create a report to present outside of the XD application.
• Exporting region intensities
Export the intensity values of voxels in a finding.
• Exporting an RTSS
You can export a radiotherapy structure set (RTSS).
• Exporting secondary captures
Export secondary captures as different image types or a DICOM object.
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Saving a session
Summary: You can save your current session and return to it later.

About
When you save a session, the results of your actions are retained so that, when you resume your session, you can continue
where you left off. This includes changes such as review mode, segmentation, registration, and quantification.

Procedure
To save your current working session, complete the following steps:

1. Click the File menu and select Save session… The Save session window opens.

2. In the Series information section, from the drop-down menu select the image set that you want to associate the saved
session with. When you launch XD using that image set as part of your selection, the saved session will be available.

3. In the Series description field, provide a description for your saved session.

4. From the Destination drop-down menu, select the destination of the saved session.
• Selecting File will save the session as a file in your filesystem.
i. In the Directory field, provide the directory in which to save the file. You can also click … to browse for
your directory.
ii. In the Filename field, provide a file name for your session.
iii. From the File format drop-down menu, select the type of file you would like to save your session as.

• Selecting Mirada DBx will save the session within DBx.

Related topics:
• Loading a session
You can resume a previous XD session.
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Loading a session
Summary: You can resume a previous XD session.

About
As part of the process of launching XD, you can load a saved session.

Procedure
To load a saved session, complete the following steps:

1. In ISP, locate and select your saved session and the datasets with which it is associated. You can also load additional data,
such as follow-up scans.

2. Launch XD. The Select session window opens.

3. Select your saved session and then click OK.

4. Perform data configuration as you would when launching XD normally. For more information, see Launching XD review
modes.

Note: Registrations loaded as part of a saved session will override any default registrations. You should ensure
that these loaded registrations are correct.

Related topics:
• Saving a session
You can save your current session and return to it later.
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Exporting data
Summary: Export data for use outside of your session.

About
You can export parts of your session to various destinations for later use or for record.

Procedure
To export data from XD, complete the following steps:

1. (Optional) If you are intending to export a range of slices, click a view of the orientation that you want to export the slices of.

2. Click the File menu and select Export.
3. Depending on what you would like to export, complete one of the following sets of steps:
• If you want to export a whole data series, complete the following steps:
i. Select Original Data and then click OK.
ii. From the Data to export drop down menu, select the specific data series that you want to export.

• If you want to export volumes that have been resampled so that they are registered, and their slice thicknesses,
resolutions, and geometries are equivalent, complete the following steps:
i. Select Resampled Volumes and then click OK.
ii. From the Associate with drop down menu, select the dataset to export.
iii. From the Volume to export drop down menu, select the volume that you want to resample and export.
iv. From the Resample to match drop down menu, select the volume that you would like to use the
resolution, slice thickness and geometry of.
v. (Optional) In the Series description field, provide a description of your resampled volume.
vi. (Optional) In the Performing physician field, provide a name for the performing physician.
vii. (Optional) In the Operator name field, provide a name for the operator.

• If you want to export the transformation of a registration as a DICOM registration object, complete the following
steps:
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i. Select Registration and then click OK.
ii. From the Associate with drop down menu, select the data series that you want to associate the
registration with.
iii. From the Registration drop down menu, select the particular registration that you want to export.
iv. (Optional) In the Description field, provide a description of the registration.
v. (Optional) In the Creator Name field, provide a name for the creator of the registration.

• If you want to export a subset of a volume’s slices as a new volume, complete the following steps:
i. Select Slice Range and then click OK.
ii. Use the sliders on the image or the Start and End fields to specify a range of slices to use.
iii. Use the Interval field to specify the interval between slices in the original image for slices in the
exported data. An interval of 0 will skip no slices and export every slice, while an interval of 1 will skip
one slice between exported slices, and so on.
iv. Use the Include patient information check box to specify whether the exported slices should contain
patient information.
v. Use the Width and Height fields to specify the size of the image to be exported.
vi. Click Continue.
vii. From the Associate with drop down menu, select the data series that you want to associate the
registration with.
viii. (Optional) In the Series description field, provide a description of your resampled volume.
ix. (Optional) In the Performing physician field, provide a name for the performing physician.
x. (Optional) In the Operator name field, provide a name for the operator.
xi. (Optional) In the Modality field, enter the modality of the slices.

4. From the Destination drop down menu, select to where you want to export. Depending on the location you select you might
have other fields to complete.
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Note: You can export to File, to the launching application, or to any SCP configured through the Options
window.

5. Click OK.

Related topics:
• Exporting a maximum intensity projection (MIP)
You can export a maximum intensity projection.
• Exporting an RTSS
You can export a radiotherapy structure set (RTSS).
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Exporting a maximum intensity projection (MIP)
Summary: You can export a maximum intensity projection.

About
Maximum intensity projections are exported as a set of two-dimensional images from different angles and can be exported in a
number of file formats.
Warning: The Maximum Intensity Projection or MIP Renderer is a tool for data visualization in 3D and is
useful for obtaining an overview of the areas within the image data of a high intensity and as a tool to
navigate to those regions. The MIP should not be used as the sole view used to interpret the image data.

Procedure
To export a maximum intensity projection, complete the following steps:

1. Select a viewport that you want to take an MIP from and then click the Display the series in the selected view as a MIP in
a floating window icon

. For more information on viewing and manipulating your MIP, see Viewing a maximum intensity

projection (MIP).

2. Click the File menu and then select Export…

3. In the Export window, select MIP Images and then click OK.

4. Use the Start and End fields to specify a range of angle markers to create images for.

5. (Optional) Deselect Include patient information if you do not want the export to include patient information.

6. Use the Width and Height fields to specify the size of the image you produce, in pixels.

7. Click Continue…
8. (Optional) In the Series information section of the Export window, provide information about the image series. This
information is only relevant when exporting in DICOM format.
• From the Associate with drop-down menu, select an image with which to associate the exported MIP.
• (Optional) Provide a description of the series in the Series description field.
• (Optional) Provide the name of the performing physician in the Performing physician field.
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• (Optional) Provide the name of the operator in the Operator name field.
• If necessary, correct the modality listed in the Modality field.
9. In the Send To section of the Export window, specify details of the file and its location.
a. From the Destination drop-down menu, select the manner in which you want to export the MIP. If you selected File,
complete the following steps:
i. In the Directory field, specify the location in which the exported MIP should be saved. You can also browse for the
location by clicking …
ii. In the Filename field, provide a name for your file, this will have _X appended to it, where X is the number of the angle
marker.
iii. From the File format drop-down menu, select the format in which you would like to save your exported MIP.
10. Click OK.

Related topics:
• Viewing a maximum intensity projection (MIP)
You can view a maximum intensity projection of your dataset.
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Creating a DICOM viewer
Summary: You can create a folder containing everything needed to view your currently loaded images.

Prerequisites
If you want to burn a viewer to CD, your system must be capable of writing to CDs.

About
If you want to enable someone to view images and findings without installing the entire XD application, you can create and
provide them with a DICOM viewer.
A DICOM viewer contains the data you are using in your current session, as well as a reduced form of the XD application with
which to view the data.

Procedure
To create and use a DICOM viewer, complete the following steps:

1. Click the File menu and select Create Viewer.

2. From the Destination drop down menu, select Filesystem to save the viewer as a folder in your file system, or select Burn
to CD to burn the viewer to a CD.

3. (Filesystem only) In the Folder name field, enter the name of a new folder in which to save the viewer and use the Location
field to specify where that folder should be saved. You can click the … button to browse for a location.

4. Use the Include regions, measurements and bookmarks check box to specify whether you want to include findings and
bookmarks in the viewer, as well as the DICOM data you loaded into the application originally.

5. Click OK.

6. To launch the viewer application, open the folder or disc drive and launch the XDViewer application. The viewer behaves in
the same manner as the main XD application, but with limited functionality.

Related topics:
• Manipulating images
Adjust your view of an image.
• Findings
Topics describing the creation and editing of regions and rulers.
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Creating a report
Summary: Create a report to present outside of the XD application.

About
When you need to present data to patients or other practitioners, you can create and customize a report and then export it as
a PDF file or as several images.

Procedure
To create and export a report, complete the following steps:

1. Click the view button in the top right of the window and select Report, or click the Window menu and select Report.
In the Reports view, different pages of the report are displayed as tabs at the top of the window and the report itself is
previewed in the main pane. In the toolbox, various tools are available for customizing your report.

2. In the Reporting Tools section of the toolbox, use the Templates drop down menu to select a template to use for your
report and then click Restore to load the template.
If you are happy with the layout of the template, skip to step 12. Otherwise, continue with the next steps to customize your
report.

3. To add a text box to your report, click Text. If there is space on the current page of the report, the text box is placed on your
current page. If there is insufficient space, it is placed on the next page. Double click a text box to edit the text in it.
4. To add a statistics table to your report, complete the following steps:
a. Click Statistics.
b. From the Select quantification table drop down menu, select which table from the Findings view you want to use.
c. From the Show statistics for drop down menu, select the data role that you want to show statistics for.
d. Click OK.
5. To add information about data quality control to your report, complete the following steps:
a. Click Data QC.
b. From the Show Data QC for drop down menu, select the data role that you want to show data QC for.
c. Click OK.
6. To add patient information to your report, click Patient Info.

7. To add a secondary capture to your report, double click the secondary capture in the Image Gallery section of the toolbox,
or drag the secondary capture across to the report page.
8. With the exception of headers and footers, you can edit elements on a report page. To do so, perform one or more of the
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following actions:
• Move an element by clicking and dragging it.
• Resize an element by clicking it and then using the corner anchors to resize it.
• Change the layering of elements by right clicking the element and selecting Bring to front, Send to back, Bring
forward, or Send backward to move the element to the top layer, bottom layer, next layer up, or next layer down
respectively.
• Delete an element by right clicking the element and selecting Delete.
9. To edit entire pages, perform one or more of the following actions:
• Click Add Page to add a new page to your report.
• Click Remove Page to remove the current page from your report.
• Click Flip Page to switch a page between portrait and landscape orientations.
• When statistics change elsewhere in your session, click Refresh to update the report to include the latest
statistics.

10. To customize your header and other report settings, click Options. For more information about using the Options window,
see Setting user preferences.

11. To save a customized template, click Save Template. Later, you will be able to select this from the Templates drop down
menu.
12. To export your report, complete one of the following sets of steps:
• To export your report as a set of images, complete the following steps:
i. Click Export.
ii. From the Associate with drop down menu, select the dataset with which you would like to associate
the report.
iii. (Optional) In the Series description field, provide a description of the report.
iv. (Optional) In he Performing physician field, provide the name of the performing physician.
v. (Optional) In the Operator name field, provide the name of the current operator.
vi. (Optional) In the Modality field, provide the imaging modality used.
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vii. From the Destination drop down menu, select to where you would like to export your report.
Depending on what you select, you might have to complete further fields.
viii. Click OK.

• To export your report as a PDF file, complete the following steps:
i. Click Create PDF.
ii. Browse for the location to which you would like to save your report.
Note: When a PDF is generated, sizes and ratios are based on your current display. As
such, it is recommended that you maximize the application window before generating a
PDF.

Related topics:
• Findings
Topics describing the creation and editing of regions and rulers.
• Quantification
Topics describing the use of XD features to perform quantification.

Mirada Medical, XD 3.6.11 Help Guide - mm8670-3.6.11-0

105

Exporting region intensities
Summary: Export the intensity values of voxels in a finding.

Prerequisites
To complete this topic, you must first have created a region or ruler.

About
You can export, as an XML or CSV file, the intensities of voxels in a region or along a ruler.

Procedure
To export the intensities of a region or ruler, complete the following steps:

1. Click the File menu and select Export Region Statistics.

2. From the Timepoint drop down menu, select the timepoint for which you want to export voxel intensities.

3. From the Role drop down menu, select the data role for which you want to export voxel intensities.

4. From the Destination drop down menu, select CSV File to export the voxel intensities as a CSV file, or select XML File to
export the voxel intensities as an XML file.

5. In the Directory field, enter the location in your file system to which you want to save the file. You can also browse your file
system by clicking …

6. Click OK.

Related topics:
• Findings
Topics describing the creation and editing of regions and rulers.
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Exporting an RTSS
Summary: You can export a radiotherapy structure set (RTSS).

Prerequisites
To complete this task, you must have created at least one region.

About
Having created regions on an image, you can export a radiotherapy structure set for use outside of XD in a treatment planning
system (TPS).
Warning: XD 3.6.11 creates the DICOM RT Structure Sets from the selected region as specified in the
DICOM Standard. RTP systems may apply interpolation between the encoded contour control points that
differs from their display in XD 3.6.11. We recommend that the user takes screenshots of the regions used to
create the contours, on an acquisition orientation view, and uses these to compare to the contour displayed
within the RTP system to ensure that the imported contour is an accurate representation.

Warning: Different interpolation methods may be used by XD 3.6.11 and TPS systems when displaying
contours. This means that when viewing findings in the acquisition orientation, they may appear visually
different between systems. It is recommended that screenshots of loaded findings be taken in the acquisition
view and compared to the same findings as displayed on the TPS to ensure that the imported structures are
accurately represented in XD 3.6.11.

Procedure
To export an RTSS, complete the following steps:
1. Click File and select Export
2. Select RTSS and then click OK.

3. From the Associate with drop down menu, select the data series with which you would like to associate your exported
RTSS.

4. From the Export structures for drop down menu, select the datasets from which you want to export regions.

5. From the Regions to export list, select the regions that you would like to export.

6. (Optional) In the Label field, enter the label of the RTSS.
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7. (Optional) In the Name field, provide a name for the RTSS.

8. (Optional) In the Description field, enter a description of the RTSS.

9. (Optional) In the Operator name field, provide a name for the operator.

10. Use the Export original dataset check box to specify whether the original or modified dataset should be exported.

11. From the Destination drop down menu, select the location to which you would like to export. Depending on the destination
you select, there might be additional fields to complete.
12. Click OK.

Related topics:
• Findings
Topics describing the creation and editing of regions and rulers.
• Quantification
Topics describing the use of XD features to perform quantification.
• Exporting data
Export data for use outside of your session.
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Exporting secondary captures
Summary: Export secondary captures as different image types or a DICOM object.

Prerequisites
To complete this task, you must first have created at least one secondary capture. For more information, see Capturing an
image.

Procedure
To export one or more secondary captures, complete the following steps:
1. In the Image Gallery section of toolbox, select the secondary captures that you want to export.

Note: You should ensure that the slice number is displayed in your secondary captures as there will be no other
way of identifying the location of the image upon export.

1. Click Export.

2. From the Associate with drop down menu, select the dataset with which you want to associate the exported images.

3. (Optional) In the Series description field, provide a description of your image series.

4. (Optional) In the Performing physician field, provide the name of the performing physician.

5. (Optional) In the Operator name field, provide the name of the operator.

6. (Optional) In the Modality field, enter the image modality.

7. (If exporting multiple images) Use the Export as single series check box to specify whether the images are exported as
one series or as multiple series.

8. From the Destination drop down menu, select the manner in which you would like to export your secondary captures.
Depending on your choice, you might need to perform further configuration.

9. Click OK.
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Related topics:
• Capturing an image
You can capture views for later reference or for use outside of XD.
• Using the findings table
Use the findings table to view statistics calculated for various regions and rulers.
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Keyboard shortcuts
Summary: A list of the available keyboard shortcuts in the XD application.

Action

Keyboard shortcut

Description

Toggle between Time Points

Space Bar

Toggles between time points
when multiple time points are
loaded in a review mode and a
single time point layout is used.

Zoom

Ctrl + mouse wheel

Magnifies images in the selected
image window.

Pan

Ctrl + left mouse button

Pans images in the selected
image window.

Undo

Ctrl + Z

Undo last step.

Redo

Ctrl + Y

Redo last step.

Ctrl + C

Only available from the Report
screen – copies items from a
page on the report to allow them
to be pasted on the same or a
different page.

Ctrl + X

Only available from the Report
screen – cuts items from a page
on the report to allow them to be
pasted (moved) to an area on the
same or a different page.

Paste

Ctrl + V

Only available from the Report
screen – pastes a previously cut
or copied item from a page on
the report.

Delete Report Item

Delete

Only Available from the Report
screen – deletes the selected
item on a report page.

Adjust paintbrush diameter

Shift + mouse wheel

Only available when using brush
tools (paint and erase tools) –
increase or decrease the
diameter of the brush tool. The
depth is unaffected.

Capture View

Ctrl + E

Sends the selected view to the
Image Gallery.

Copy

Cut
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Action

Keyboard shortcut

Description

Capture Screenshot

Ctrl + Shift + E

Sends a screenshot of the
selected application window to
the Image Gallery.

Copy View to Clipboard

Ctrl + K

Copies the image in the currently
selected view to the clipboard.

Copy Screenshot to Clipboard

Ctrl + Shift + K

Copies a screenshot of the
currently selected application
window to the clipboard.

Help

F1

Opens the help file.

Full Screen

F11

Displays the application as full
screen, removing toolbar and
toolbox

Return to Layouts

CTRL + Left

Returns the selected window
from specific screens to the
image layouts

Rigid Registration

F2

Applies the automatic rigid
registrations defined in the
review mode.

F5

Applies the automatic
deformable registrations defined
in the review mode.

SHIFT+CTRL+F

Shows the displacement field
when a deformable registration
exists between the datasets
visible in a fused image view

SHIFT+CTRL+G

Shows the deformation grid
when a deformable registration
exists between the datasets
visible in a fused image view

SHIFT+CTRL+M

Shows the deformation map
when a deformable registration
exists between the datasets
visible in a fused image view

Up Arrow

Increases the slice index by one
in the selected view. E.g. if the
currently selected view is a
Coronal view at slice index 314,
pressing the up arrow increases
the slice index in the Coronal
view to 315.

Deformable Registration

Show Displacement Field

Show Displacement Grid

Show Displacement Map

Increase Slice Index
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Action

Keyboard shortcut

Description

Down Arrow

Decreases the slice index by one
in the selected view. E.g. if the
currently selected view is a
Sagittal view at slice index 112,
pressing the down arrow
decreases the slice index in the
Sagittal view to 111.

Page up

Increases the slice index by one
in the selected view by 10. E.g. if
the currently selected view is a
Coronal view at slice index 314,
pressing the up arrow increases
the slice index in the Coronal
view to 324.

Decrease by 10 slices

Page down

Decreases the slice index by one
in the selected view by 10. E.g. if
the currently selected view is a
Sagittal view at slice index 112,
pressing the down arrow
decreases the slice index in the
Sagittal view to 102.

Restore Object selection mode

Escape

Exits control modes such as
window level control mode

Show/Hide Volume Bounds

B

Toggles display of Volume
Bounds in the display window.

Toggle Annotations

A

Removes annotations from the
image views

Toggle Navigation Controls

N

Show/Hide navigation controls

Remove Crosshairs

C

Removes crosshairs from the
image views.

Remove Information Overlays
from the image views

I

Removes the Information
Overlays from the image views

T

When launched with more than
one timepoint, displays the
timepoint name and date in the
image views.

Decrease Slice Index

Increase by 10 slices

Show Timepoint Information
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Action

Keyboard shortcut

Description

Toggle Overlay

O

Toggles the overlay between the
current transparency setting and
fully transparent. This has the
effect of showing and hiding the
overlay. This is only available if
the currently selected view has
both a base and overlay dataset.

Remove Patient Information
overlays from image views

P

Removes the Patient Information
from Image Views.

Show/Hide Region Statistics

S

Toggles display of region
statistics on and off in the display
window.

Toggle ROIs

R

Removes ROIs and associated
text from the image views

Toggle Region Crosshair Display

V

Displays the crosshair ROI

Increase Volume Crosshair Size

=

Increase the volume contained
by the volume crosshairs.

Decrease Volume Crosshair Size

-

Decrease the volume contained
by the volume crosshairs

Ellipse Region Tool

CTRL+L

Selects the Ellipse Region tool

Rectangular Region Tool

CTRL+R

Selects the Rectangular Region
tool

Paint Tool

Q

Selects the Paint tool for region
editing.

Eraser Tool

W

Selects the Eraser tool for region
editing.

Toggle PET AC/NAC

T

Switches between the NAC and
AC datasets for the selected PET
or SPECT dataset.

Delete Object

Delete

Deletes the currently selected
annotations, rulers, angles or
regions.

View Context Menu

Right Mouse button

Displays the floating toolbar (also
known as context menu) in an
image window.
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Action

Keyboard shortcut

Description
This action depends on the
currently selected view and
preference setting:
System preferences set to
navigate by slice number:
• Axial: moves to the axial slice
index at the bottom of the patient
• Coronal: moves to the coronal
slice index with the highest value

Move to Start

Home

• Sagittal: moves to the sagittals
slice index with the highest value
System preferences set to
navigate by anatomy:
• Axial: moves to the most inferior
slice in the axial view
• Coronal: moves to the most
posterior slice in the coronal view
• Sagittal: moves to the most
leftward slice in the sagittals view
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Equations and algorithms
Summary: In this section you can find information about the equations and algorithms used to calculate various statistics in
the XD application.
It is important to understand the means by which a statistic was calculated. The topics in this section provide details of the
functioning of the algorithms and equations used by XD.

Topics in this section:
• Statistics
Standard statistics that can be included in the findings table.
• Calculation of statistics for gated data
The method by which multiple statistics are calculated when multiple gates are available.
• Derived statistics
The manners in which derived statistics are calculated.
• SUV Peak
The SUV Peak calculation is a method to provide a robust measure of tracer activity in PET imaging.
• Volume doubling time
The equation used to calculate the volume doubling time.
• PET SUV calculation by body weight
The equation used to calculate PET SUV by body weight.
• PET SUV calculation by body surface area
The equations used to calculate PET SUV by body surface area.
• PET SUV calculation by lean body mass
The equations used to calculate PET SUV by lean body mass, for male and female patients.
• PET SUV from acquisition
Scanner manufactures can calculate and store a PET SUV value.
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Statistics
Summary: Standard statistics that can be included in the findings table.
The statistics in this table are available across the Intensity Distribution, PERCIST, RECIST, Regions Tracking, WHO, and
Advanced tabs. Their display for a given tab can be turned on or off by clicking Options in the Settings section of the
toolbox, when viewing the Findings Table.
Note: All statistics can be displayed by the Advanced tab. Only relevant statistics are available in the other tabs
Further aggregated and derived statistics are also available in Calculation of statistics for gated data and Derived statistics.

Statistic

Definition

Max

The maximum voxel intensity of all the voxels
included in the region.

Min

The minimum voxel intensity of all the voxels
included in the region.

Mean

The mean voxel intensity of all the voxels included
in the region.

Median

The median voxel intensity of all the voxels included
in the region.

StdDev

The standard deviation of the voxel intensity of all
the voxels included in the region.

Threshold

The lower threshold value of an isocontour region. It
is not generated for other finding types.

Upper Threshold

The upper threshold value of an isocontour region. It
is not generated for other finding types.

Volume

The volume, in cm3, of the region.

MTV (Displayed as Volume)

Metabolic Tumor Volume. The product of the
number of voxels in the region and the volume of
each voxel.

Volume Doubling Time

The time, in days, that it would take the region to
double in volume. For more information, see Volume
doubling time.

Peak

The PERCIST peak of the finding. For details of its
calculation, see SUV Peak.

BiRuler Long Axis

The long axis measurement of a 2D bi-ruler.

BiRuler Short Axis

The short axis measurement of a 2D bi-ruler.
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Statistic

Definition

BiRulerAuto

If the finding has been marked as a lymph node, this
is the short axis measurement of a 2D bi-ruler.
Otherwise, this is the long axis measurement of a
2D bi-ruler.

UniRuler Length

The length of a 1D ruler.

Angle

The angle, in degrees, measured by an angle ruler.

BiRuler Product

The product of the long and short axes of a BiRuler.

Max Ratio to Reference Mean

The ratio of the maximum voxel intensity in a region
to the mean voxel intensity of that region in the
reference volume.

Mean Ratio to Reference Mean

The ratio of the mean voxel intensity in a region to
the mean voxel intensity of that region in the
reference volume.

Mean Range

The product of the maximum and minimum mean
voxel intensity of the region when there are multiple
volumes within a single time point.

Mean Ratio

The ratio of the maximum and minimum mean voxel
intensity of the region when there are multiple
volumes within a single time point.

TLG (Total Lesion Glycolysis)

For a PET region, this is calculated as the product
of the MTV and the Mean activity across the region,
using the SUV that is calculated as specified
through the Quantification Options window.

Note: When datasets have been transformed for display, quantification calculations are performed on the
original image space, not the resampled and transformed space.

Warning: Automatically shadowed regions will be quantified in the resolution of the dataset onto which
the region was shadowed. Only voxels whose center lies within the region are considered when
calculating statistics. If the dataset on which the original region was defined and the dataset onto which the
region was shadowed are of a different resolution, the regions may have a different Volume statistic as the
volume will always be a multiple of the voxel volume of the dataset on which the region is defined. For instance,
a region defined on a CT dataset and automatically shadowed onto the PET may have a different Volume
statistic when calculated on the CT compared the Volume statistic calculated on the PET if the CT dataset is of a
different resolution to the PET. It follows that any statistic derived from the Volume statistic (e.g. Volume
Doubling Time) will be different for a finding shadowed between a pair of datasets if the Volume statistic is
different for that finding.
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Calculation of statistics for gated data
Summary: The method by which multiple statistics are calculated when multiple gates are available.

About
When a time point contains gated data, more than one value for a statistic might be created, depending on the statistic. When
this is the case, an aggregate statistic is calculated, for each time point, from the statistics calculated from each gate.

Aggregation methods
The following table details the methods used to aggregate statistics:

Statistic

Aggregation method

Max

The maximum value of any considered gate is used

Min

The minimum value of any considered gate is used

Mean

The mean value of the means calculated for each
gate is used. This is equivalent to the overall mean
of all the gates

Median

The mean value of the medians calculated for each
gate is used.

StdDev

The mean value of the standard deviations
calculated for each gate is used.

Threshold

The threshold is only presented when the threshold
is equivalent across all considered gates.

Upper Threshold

The upper threshold is only presented when the
upper threshold is equivalent across all considered
gate.y

Volume

The mean of the volumes calculated for the region
in each considered gate is used.

Volume Doubling Time

No value generated as aggregation takes place
within a time point.

Peak

The maximum of the peaks of all the considered
gates is used

BiRuler Long Axis

The maximum of the long axes of the bi-ruler in all
of the considered gates is used.

BiRuler Short Axis

The maximum of the short axes of the bi-ruler in all
of the considered gates is used.
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Statistic

Aggregation method

BiRuler Auto

The maximum of the axis of the automatic bi-ruler in
all of the considered gates is used.

UniRuler Length

The maximum of the length of the uni-ruler in all of
the considered gates is used.

Angle

The mean of the angle measured in all of the
considered gates is used.
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Derived statistics
Summary: The manners in which derived statistics are calculated.

About
When a time point contains gated data, more than one value for a statistic might be created, depending on the statistic.
Additionally, a derived statistic is calculated using one or more existing statistics. When a derived statistic is calculated for a
gated time point, different methods are used to calculate the derived statistic.

Aggregation methods
In the table later in this topic that describes the derivation of statistics from aggregated statistics, the following notation is used
to describe aggregation methods:

Statistic representation

Aggregation method

mean(Statistic)

The mean of the statistic from each gate that is
considered.

max(Statistic)

The maximum value of all the values of the statistic
from each gate that is considered.

min(Statistic)

The minimum value of all the values of the statistic
from each gate that is considered.

isSame(Statistic)

A value is only returned for the statistic when its
value is equivalent in all gates. This extends to the
whole of a derived statistic.

where, in all representations of an aggregation method, Statistic refers to a particular statistic of the same name.
More information on aggregation methods for different statistics can be found in Calculation of statistics for gated data.

Derivation methods
The following table details the methods used to derive statistics from aggregated statistics:

Statistic

Derivation method

BiRuler Product

Max Ratio to Reference Mean
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Statistic

Derivation method

Mean Ratio to Reference Mean

Mean Range

Mean Ratio

PERCIST Threshold Blood Pool

PERCIST Threshold Liver

The threshold to use for PERCIST regions, relative
to a defined reference bloodpool volume, using the
SUV calculation specified through the Quantification
Options window.

The threshold to use for PERCIST regions, relative
to a defined reference liver volume, using the SUV
calculation specified through the Quantification
Options window.

Theshold % of Max

Related topics:
• Statistics
Standard statistics that can be included in the findings table.
• Calculation of statistics for gated data
The method by which multiple statistics are calculated when multiple gates are available.
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SUV Peak
Summary: The SUV Peak calculation is a method to provide a robust measure of tracer activity in PET imaging.

Occurrences
The algorithm described in this topic is used by the following functions of XD:
• Performing automatic registration
• Using the findings table

Introduction
The algorithm calculates the maximum average SUV within a small ROI of a fixed size. The implementation used by XD 3.6.11
follows the definition provided in the PERCIST protocol.

The algorithm
XD 3.6.11 displays smooth images and contours, meaning that both the displayed images and contours are interpolated to
produce a display without square edges around each voxel. However, quantification is always performed on the original
voxels, thereby avoiding any form of interpolation or partial volume correction. For all ROIs, the quantified voxels are those
whose centers fall inside the curve. This is illustrated in Figure 1, where the quantified voxels have been shaded for the region
defined by the blue contour.
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Figure 1: Quantified voxels are shaded
A sphere whose diameter is approximately 1.2cm (to produce a 1cm3 volumetric sphere) is used to calculate the Peak value.
This is refered to as the SUV Peak kernel. For all voxels in a region, the SUV Peak kernel is placed such that the center of the
kernel is over the center of the voxel being assessed. The mean intensity of all voxels within the kernel is computed. The SUV
Peak is the maximum of all the mean values computed from placing the kernel at each voxel in the ROI. For voxels near the
edge of the ROI, some voxels within the SUV Peak kernel are used in the calculation of the mean SUV whether or not those
voxels are inside the region as illustrated in Figure 2.
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Figure 2: SUV Peak Kernel Counts Voxels Outside ROI
The SUV Peak kernel is also quantized using the same approach, as illustrated in Figure 3. Specifically, each voxel whose
center is inside the kernel is used for the mean calculation.

Figure 3: SUV Peak Kernel Voxels are Shaded
Warning: Due to its definition, the peak value may include voxel values from outside the ROI boundaries
when the ROI is near an adjacent area of the image with high PET values. The user should treat the peak
value with caution where high PET voxels are within 0.7 cm of the ROI boundaries.
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Volume doubling time
Summary: The equation used to calculate the volume doubling time.

Occurrences
The equation described in this topic is used by the following function of XD:
• Using the findings table

Introduction
The volume doubling time is the estimated time that the volume will take to double, calculated from two time points.

The equation
The volume doubling time can only be calculated when more than one timepoint of data has been loaded. It is based on the
rate of change of the volume statistic. The rate of change is calculated from the volume of a region at a particular timepoint
and the volume of the same (linked) region in the immediately preceding timepoint. This means that the volume doubling time
cannot be calculated for the baseline timepoint (as there is no preceding timepoint), nor can it be calculated for a region if a
linked region does not also appear in the immediately preceding timepoint.
The formula for the volume doubling time, tD, is given by the following equation:

where V0 is the volume of the region and the preceding timepoint, V(t) is the volume of the region at the current timepoint, and
t is the time, in days, between the two volume measurements.
Volume Doubling Time is not computed for a data role when a finding contains more than one region on the data role. For
instance, if two linked regions are defined on a gated CT, Volume Doubling Time is not computed for that gated CT as there is
no definitive Volume statistic.

Warning: The volume doubling time calculation becomes more robust the larger the regions become. At
small volumes where the region volume consists of only a few voxels, the potential error in the reported
volume may be quite large. The user is advised to use the Data QC screen to check the voxel dimensions when
making a judgement as to how to interpret the volume doubling time. In addition, the volume doubling time
calculation may become very large and sensitive when the volumes in consecutive timepoints are similar.
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PET SUV calculation by body weight
Summary: The equation used to calculate PET SUV by body weight.
One of the methods of calculating PET SUV in XD is by body weight. The following formula is used in this calculation:

where SUV has units g/ml.
This calculation requires that the following information is available:
• Administration date/time
• Acquisition date/time
• Injected dose
• Radionuclide half-life
• Decay correction method
• Patient weight
For more information please see: Reevaluation of the Standardized Uptake Value for FDG: Variations with Body Weight and
Methods for Correction, by Sugawara et al, Radiology, November 1999.
Note: To change the method used to calculate PET SUV, click the active text for the units of the image layer in
the bottom-left corner of a view and select the method that you want to use.

Note: All calculations are performed using metric units. However, it is possible to specify height and weight using
Imperial units. In this case XD uses the Avoirdupois Pound and considers a stone equivalent to fourteen pounds.
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PET SUV calculation by body surface area
Summary: The equations used to calculate PET SUV by body surface area.
SUV by body surface area (BSA) is calculated by using an approximation of the body surface area. The following formula is
used for this calculation:

Where SUV has units cm2/ml and the BSA is approximated using the following formula (by Du Bois and Du Bois):

This calculation requires that the following information is available:
• Administration date/time
• Acquisition date/time
• Injected dose
• Radionuclide half-life
• Decay correction method
• Patient weight
• Patient height
For more information please see: Reevaluation of the Standardized Uptake Value for FDG: Variations with Body Weight and
Methods for Correction, by Sugawara et al, Radiology, November 1999.
Note: To change the method used to calculate PET SUV, click the active text for the units of the image layer in
the bottom-left corner of a view and select the method that you want to use.

Note: All calculations are performed using metric units. However, it is possible to specify height and weight using
Imperial units. In this case XD uses the Avoirdupois Pound and considers a stone equivalent to fourteen pounds.
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PET SUV calculation by lean body mass
Summary: The equations used to calculate PET SUV by lean body mass, for male and female patients.
SUV by Lean Body Mass (depending on the sex of the patient) is calculated using the following formula:

where SUV has units g/ml and the lean body mass (LBM) is approximated by using the following formulae:

Note that the LBM must be converted into grams in order to be used in the SUV equation.
This calculation requires that the following information is available:
• Administration date/time
• Acquisition date/time
• Injected dose
• Radionuclide half-life
• Decay correction method
• Patient weight
• Patient height
• Patient sex
For more information please see: Reevaluation of the Standardized Uptake Value for FDG: Variations with Body Weight and
Methods for Correction, by Sugawara et al, Radiology, November 1999.
Note: To change the method used to calculate PET SUV, click the active text for the units of the image layer in
the bottom-left corner of a view and select the method that you want to use.

Note: All calculations are performed using metric units. However, it is possible to specify height and weight using
Imperial units. In this case XD uses the Avoirdupois Pound and considers a stone equivalent to fourteen pounds.
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PET SUV from acquisition
Summary: Scanner manufactures can calculate and store a PET SUV value.
The PET SUV from acquisition is not calculated by XD and is instead retrieved from the DICOM data of the dataset.
Warning: The PET SUV from Acquisition calculation underlying the display of this quantification option is
outside the control of Mirada Medical. When PET SUV from Acquisition displays values, the number
displayed is based on the stored value in the image data. Please contact your vendor for further information on
this topic.

Note: To change the method used to calculate PET SUV, click the active text for the units of the image layer in
the bottom-left corner of a view and select the method that you want to use.
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